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Module 1: Course Navigation 
Lesson 1: ACE Web-based Training Navigation 
 
 
Lesson 1: Automated Commercial Environment (ACE) Web-based 
Training Navigation 
 
After completing this lesson, you will be able to: 
 

• Explain the ACE Web-based training course structure.  
• Use the Navigation Bar buttons to move through course screens. 
• Use interactive course features such as rollovers and 

simulations. 
 
 
Course Disclaimer 
 
The names of companies and persons mentioned in all ACE Web-based 
training courses are fictional. Information related to addresses, e-
mails, phone numbers, license numbers, etc, is used solely for 
instructional purposes and should not be considered valid data. 
 
Course screenshots and simulations of the ACE Secure Data portal 
were captured from a test environment; as a result, slight differences 
may occur in the look and functionality of ACE due to date of 
publishing. 
 
 
Course Structure 
 
Each ACE Web-based training course follows a module and lesson 
structure.  Each module is divided into a number of lessons. 
 
The course menu reflects a list of modules on the left and the 
associated list of lessons on the right. To begin the course, select a 
module name and then the lesson name. 
 
Each ACE Web-based training course is designed to allow you to 
proceed at your own pace. You can complete the course modules and 
lessons in one sitting or in stages. 



Web-based Training Guide for  Module 1, Lesson 1 
ACE Reports for Trade 

4 

 
 
You have completed Lesson 1: ACE Web-Based Training Navigation. 
 
In this lesson you learned how to navigate an ACE Web-based training 
course. 
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Module 2: ACE Reports 
Lesson 1: Introduction to Reports 

 
In Lesson 1: Introduction, you will learn about the features and 
capabilities of ACE Reports and the InfoView interface portal.  
 
After completing this lesson, you will be able to: 
 

• Describe the purpose of ACE Reports. 
• Identify the source of the report data. 
• Identify the tool used for reports. 
• Identify the most used trade reports. 

 
ACE Reports is an application used to pull reports from the ACE Portal. 
ACE Reports uses an application called InfoView to generate reports 
and allow you to modify those reports to suit your needs. 
 
The InfoView interface provides robust reporting capabilities to ACE 
users with an easy-to-use interface, scheduling features, and rich 
report formatting/customization. 
 
ACE Reports data comes from: 
 

Collecting Report Data: Data is collected from several sources, 
including ACS, and transferred to a secure dedicated server. 

 
Warehouse Data: Data is stored on a secure dedicated server 
that serves as the resource for report data. Periodic Monthly 
Statement data is refreshed on an hourly basis. All other report 
data is refreshed on a daily basis. 

 
Utilizing Reports: The Ace Reports user request a report through 
the InfoView interface. The interface will request report data 
from the secure dedicated server and will pass this along to the 
user. These reports can be manipulated in multiple ways using 
tables, charts and other formats. 

 
There are several categories of ACE Reports, which are described 
below: 
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Account Management: Account Management reports consist of 
Account Profile, Cargo Entry, Cargo Exam, Entry Summary and 
Entry Summary Compliance Reports. 

 
Account Revenue: Account Revenue reports are only for 
Importers and Brokers participating in Periodic Monthly 
Statement. 

 
Transactions: Transaction reports are designed for carriers. 
These reports consist of e-Manifest data filed via Electronic Data 
Interchange (EDI) and via the ACE portal. 

 
To Summarize… 
 

• You learned how ACE Reports are used, where the information 
comes from and how the data is accessed. 

 
• You also learned about some of the most frequently used reports 

and where to find them. 
 
 
Knowledge Check Question 1 
 
Which of the following correctly describes the purpose of the Reports 
feature in ACE? 
 
A) To filter and display active manifests. 

 
B) To create and track business goals. 
 
C) To view and respond to risks and solutions agreed to by CBP and an 
account representative. 
 
D) To Analyze Account Information within the ACE portal. 
 
The correct answer is D. 
 
 
Knowledge Check Question 2 
 
Report data is refreshed on a monthly basis only. 
 
A) True 
 



Web-based Training Guide for  Module 2, Lesson 1 
ACE Reports for Trade 

7 

B) False 
 
The correct answer is B. 
 
 
You have completed this Lesson. In this lesson, you learned 
background information on ACE Reports and identified which reports 
will be the most useful to you. 
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Lesson 2: InfoView Interface 
 
In Lesson 2: InfoView Interface, you will learn how to launch InfoView 
from the ACE Portal and navigate the reports interface, folders and 
toolbars. 
 
After completing this lesson, you will be able to: 
 

• Navigate to the reports tab in ACE portal. 
• Launch and navigate the InfoView Interface. 
• Use the buttons, toolbars and other components of the report 

interface. 
 
You have logged into the ACE portal. Your view is the Home tab in the 
Importer View. In order to reach the Reports functionalities, navigate 
to the Accounts tab. 
 
The ACE secure data portal contains four tabs at the top of the screen. 
These tabs, moving from left to right across the screen are Home, 
Accounts, References, and Tools. 
 
Select the Accounts tab. 
 
Notice that the Account Type drop-down menu in the top left corner 
indicates Importer. Therefore, the tasks relevant to Importer are 
available on the page. However, Importer is not the default view. The 
view that you see depends on the one you select when you log into the 
system. 
 
The ACE secure data portal Accounts page contains the Task Selector 
panel on the left side of the screen. Within the Task Selector panel is 
the Account Type drop-down menu. Depending on the Account Type 
selected, different tasks display directly below the drop-down menu. 
 
Select the Reports link. 
 
To launch the ACE Reports Tool, select the Launch Tool button. 
 
Important Note: A pop-up blocker may not allow you to launch the 
Reports tool. You should turn off your pop-up blocker prior to 
launching the Reports tool. 
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The ACE secure data portal Accounts page displaying the Launch 
Reports and Quickview Tool panel. The Launch Reports and Quickview 
Tool panel contains a Launch Tool button. 
 
Select the Launch Tool button. 
 
You are now at the Welcome to ACE Reports Home page of the 
InfoView portal. Along the top of the portal, you see a gray toolbar 
that displays several icons that you will use to perform actions within 
InfoView.  
 
The house icon on the far left of the toolbar will return the Workspace 
panel to this page. The square icon to the right of the house allows 
you to show or hide the Navigation Panel.  
 
The ACE secure data portal Reports Home page, which is divided into 
two panels: the Navigation Panel and the Workspace panel. 
 
Select the Toggle Navigation icon. 
 
The Navigation panel is now hidden. Hiding the Navigation panel 
allows you to maximize the Workspace panel. Select the Toggle 
Navigation icon to display the Navigation panel again. 
 
Note: You can also hide the Navigation panel by selecting the Arrow in 
the upper right hand corner of the panel. 
 
The ACE secure data portal Reports Home page displays, containing 
only the Workspace panel. 
 
Select the Toggle Navigation icon. 
 
Our next section of the toolbar contains three buttons: 
 

• New 
• Refresh 
• My InfoView 

 
The New button creates a new folder. Use this button to create new 
folders in the My Folders portion of InfoView. 
 
The ACE secure data portal Reports Home page, displaying the 
Navigation panel and the Workspace panel. Zoom-in animation allows 
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the New, Refresh, and My InfoView icons to be enlarged and centered 
in middle of page. 
 
The ACE secure data portal Reports Home page, displaying the 
Navigation panel and the Workspace panel. The Navigation panel 
contains a Home icon with two sub-folders (My Folders and Public 
Folders). Both of these sub-folders have folder expansion buttons, or 
plus signs, to their left. 
 
Select the + next to My Folders. 
 
The ACE secure data portal Reports Home page, displaying the 
Navigation panel and the Workspace panel. Within the Navigation 
panel, My Folders has been expanded to display two additional sub-
folders: Favorites and Inbox. Both of these sub-folders have folder 
expansion buttons, or plus signs, to their left. 
 
Select Favorites. 
 
The ACE secure data portal Reports Home page, displaying the 
Navigation panel and the Workspace panel. The Workspace panel has 
changed to show any reports contained in the Favorites folder. There 
are currently no reports in this folder. 
 
Select the New button. 
 
To create a new folder to be nested under My Folders, select My 
Folders, and then select the Favorite folder. 
 
We have selected where the new folder should go for you. Now we can 
add the new folder. 
 
The ACE secure data portal Reports Home page, displaying the 
Navigation panel and the Workspace panel. The New menu on the 
toolbar is expanded to display the option “Folder”. 
 
Select the Folder option. 
 
The Workspace panel will change to allow the creation of the new 
folder. You have the options to enter a Folder Name, Description 
and/or Keywords. Only a folder name is required to create the folder, 
but it is always a good idea to provide a description of the folder. 
 
Select Folder Name and we will fill in the information for you. 
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The ACE secure data portal Reports Home page, displaying the 
Navigation panel and the Workspace panel. The Workspace panel has 
been altered to allow the user to create a new folder. There are now 
three text boxes in the Workspace panel: Folder Name, Description, 
and Keywords. There are also two buttons: OK and Cancel. 
 
Select the Folder Name text box. 
 
The ACE secure data portal Reports Home page, displaying the 
Navigation panel and the Workspace panel. The words “AR Favorites” 
are typed in the Folder Name text box. 
 
Select the Description box. 
 
The ACE secure data portal Reports Home page, displaying the 
Navigation panel and the Workspace panel. The words “Favorite AR 
Reports” are typed in the Description text box. 
 
Select the OK button. 
 
Your new folder will be added to the selected area and you Workspace 
panel will again reflect the Home view. 
 
The icon to the right of the New icon is the Refresh icon. When 
selected, this icon will refresh your Workspace panel. 
 
The ACE secure data portal Reports Home page, displaying the 
Navigation panel and the Workspace panel. Within the Navigation 
panel, the Favorites folder has been expanded to display the new AR 
Favorites folder. This folder has a folder expansion button, or plus 
sign, to its left. The expansion button next to the Favorites folder is 
now a [-] rather than a [+], since the Favorites folder is expanded. 
 
The next toolbar icon in this section is My InfoView. My InfoView 
allows you to create custom Workspace panels. We will cover how to 
do this in a later topic. 
 
The Center item in the toolbar is Search. The search function allows 
you to search for reports by title, keyword and advanced options. 
 
The ACE secure data portal Reports Home page, displaying the 
Navigation panel and the Workspace panel. The toolbar at the top of 
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the screen contains a Search title drop-down menu with a text field to 
its right. 
 
Select Search title. 
 
After selecting how you would like to search, enter the search criteria.  
Select the text box and we will enter the information for you. 
 
For this example, we will keep the default selection. 
 
The ACE secure data portal Reports Home page, displaying the 
Navigation panel and the Workspace panel. The Search title drop-down 
menu on the toolbar is expanded to display four options: Search all 
fields, Search title, Search keyword, and Advanced search…. Search 
title is the default selection. 
 
Select the Search text box. 
 
The ACE secure data portal Reports Home page, displaying the 
Navigation panel and the Workspace panel. The word “Trade” is typed 
in the search text box. There is an arrow button to the right of the 
search text box. 
 
Select the arrow button. 
 
You now see a list of reports in the Workspace panel.  The list matches 
the search criteria you just entered.  You can use the scroll bar on the 
right to view the remainder of your search results. 
 
Return to the home screen. 
 
The ACE secure data portal Reports Home page, displaying the 
Navigation panel and the Workspace panel. The Workspace panel has 
been altered to display the results of the search.  
 
Select the House icon. 
 
The three icons on the far right side of the toolbar are: 
 

• Preferences- allow you to set how information is displayed in 
your workspace panel. 

• Log Out- is future functionality. Use X to log out of the InfoView 
interface. 
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• Help- displays the Online Help for InfoView. 
 
We will cover how to set user preferences in a later topic. Before we 
move on, we will collapse the Favorites folder. 
 
The ACE secure data portal Reports Home page, displaying the 
Navigation panel and the Workspace panel. Zoom-in animation allows 
the Preferences, Log Out, and Help icons to be enlarged and centered 
in middle of page.  
 
Select the [-] beside Favorites. 
 
Take a closer look at the Navigation panel. 
 
The Navigation panel displays folder sets that organize all of the 
various reports that can be accessed through ACE Reports.  It also has 
a toolbar that you will use for actions specific to the Navigation panel. 
 
Looking at the Navigation panel toolbar from left to right, we see: 

• Refresh Navigation panel icon-refreshes the Navigation panel 
• Properties icon- allows you to set the properties for a selected 

folder/category 
• Move icon- moves the selected folder/category 
• Copy icon-copies the selected folder/category 
• Delete icon-deletes the selected folder/category 

 
In the Navigation panel, below the toolbar, you will see a Home folder. 
Under Home, there are 2 expandable folders displayed:   

• My Folders  
• Public Folders 

 
In My Folders, there are 2 nested folders: 

• Favorites 
• Inbox 

 
The Favorites folder is where you will be able to find all the reports you 
have saved as a favorite. The Inbox is where you will find all the 
recurring scheduled reports after they have been run. We will take a 
closer look at both of these folders in a later lesson. 
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Image: The ACE secure data portal Reports Home page, displaying the 
Navigation panel and the Workspace panel. The Navigation panel 
contains the folder structure described in the screen text. There is an 
expansion button, [+], to the left of Public Folders. 
 
Select the [+] beside Public Folders. 
 
There are six nested folders under Public Folders: 
 

• Account Management 
• Account Revenue 
• Authorized Data Extract 
• Entry Summary 
• Reference 
• Transactions 

 
We will take a look at one of the folders. 
 
Each of these sub-folders has a folder expansion button, or plus sign, 
to its left. 
 
Select the Account Revenue folder 
 
The Account Revenue reports are now displayed in the Workspace 
panel.  There is also a new toolbar in the Workspace panel with three 
buttons on it: 
 

• Organize- copies reports from one folder to another. 
• Delete- deletes the selected report. 
• Filter- we will not use this feature. 

 
When you use the Organize feature, you are only able to copy reports 
into the Favorites folder and its subfolders.  You cannot copy reports to 
public folders. 
 
Below this toolbar, there is a header bar that will allow you to sort the 
reports in this folder. 
 
Within the Workspace panel, reports are listed with a description of the 
report contents (or report details) under the report name. 
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The Hide arrow allows you to minimize the report listing in the 
workspace by hiding the report details. 
 
The ACE secure data portal Reports Home page, displaying the 
Navigation panel and the Workspace panel. The Workspace panel 
currently displays the names of the Account Revenue Reports and the 
report details. Report information is listed in columns with column 
headers. The third column header is the Hide/Show All arrow. 
 
Select the Hide arrow. 
 
You can display the additional report details by selecting the show all 
arrow. 
 
The ACE secure data portal Reports Home page, displaying the 
Navigation panel and the Workspace panel. The Workspace panel 
currently displays the names of the Account Revenue Reports but not 
the report details. Report information is listed in columns with column 
headers. The third column header is the Hide/Show All arrow. 
 
Select the Show All arrow.  
 
The Workspace panel also has four features that allow you to 
maximize or minimize the Workspace.  The upward pointing arrow 
removes the InfoView header from the screen. 
 
The ACE secure data portal Reports Home page, displaying the 
Navigation panel and the Workspace panel. The Workspace panel 
currently displays the names of the Account Revenue Reports and the 
report details. In the top right corner of the InfoView header are four 
icons: upward/downward-pointing arrow, Maximize icon, Minimize 
icon, and close icon (x). 
 
Select the upward pointing arrow. 
 
To reveal the hidden InfoView header, select the downward pointing 
arrow that appears. 
 
The ACE secure data portal Reports Home page, displaying the 
Navigation panel and the Workspace panel without the InfoView 
header. 
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Select the downward pointing arrow. 
 
The Maximize icon to the right of the arrow button maximizes the 
Workspace panel, hiding both the Navigation panel and the InfoView 
header. 
 
Select the Maximize icon 
 
To minimize the Workspace panel, revealing both the Navigation panel 
and the InfoView header, select the Minimize icon. 
 
The final toolbar item, x, returns the Workspace panel to the last main 
page visited. 
 
Congratulations! You've successfully learned how to navigate through 
the ACE Reports interface. 
 
The ACE secure data portal Reports Home page, displaying the 
Navigation panel and the Workspace panel with the InfoView header. 
 
 
To Summarize... 
 
• You learned how to find and launch the InfoView interface. 

 
• You also learned how to navigate through the folders of the 

interface and utilize the buttons, toolbars and other components. 
 
Knowledge Check Question 1 
 
To access the InfoView interface, you would select the __________ 
tab of the ACE Portal. 
 

A) Home 
 
B) Accounts 
 
C) Reports 
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D) Statements 
 
The correct answer is B. 
 
 
Knowledge Check Question 2 
 
How would you hide and reveal the Navigation panel? 
 

A) Select the Toggle Navigation icon. 
 
B) Select the House icon. 
 
C) Log out of ACE Reports 
 
D) Select the Refresh icon 

 
The correct answer is A. 
 
Knowledge Check Question 3 
 
You can find your inbox folder under Public Folders. 
 

A) True 
 
B) False 

 
The correct answer is B. 
 
You have completed this topic.  In this topic, you learned how to 
launch InfoView from the ACE Portal and navigate the reports 
interface, folders and toolbars. 
 

Lesson 3: Customize me InfoView 

 
In Lesson 3: Customize InfoView, you will learn how to utilize and 
customize the My InfoView feature of ACE Reports. 
 
After completing this lesson, you will be able to: 
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• Identify the preferences that can be changed for My InfoView. 
• Customize My InfoView. 

 
The ACE secure data portal Reports Home page is displayed.  The right 
side of the screen includes the Folders display panel. 
 
We have already logged into the ACE Portal and launched ACE Reports.  
You are currently viewing the InfoView homepage. Select the My 
InfoView button on the toolbar.   
 
The My InfoView panel displays with several template options 
available.  The right side of the screen displays the Folder panel. 
 
The current view will be displayed when you select the My InfoView 
button. We will maximize our InfoView screen so that we can see 
larger pictures of the features that we will be customizing.  Notice the 
four icons on the upper right corner of the My InfoView panel.  Select 
the single square to maximize the InfoView window. 
 
Select the Maximize icon. 
 
We will use this larger view of the InfoView window and begin working 
with our first template example.  There are six templates for InfoView.  
Notice the thumbnail examples of each template option placed beside 
the words Choose Template.  You simply select which one you would 
like to use to customize My InfoView.  Use this dialogue box to 
customize each frame on your InfoView page. 
 
Within the InfoView window selected template, there is a Define 
Content hyperlink. 
 
Select the Define Content link. 
 
 
The Dashboard Properties window opens when you select the Define 
Content link.  This is the dialogue box that we will use to customize 
the different columns that will be displayed on the InfoView page.  For 
each column on your InfoView page, you will need to use this dialogue 
box to customize. 
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A pop-up Dashboard Properties dialogue box displays and is broken 
out into Web address and Object.  Object has 2 sub-folders: My 
Folders and Public Folders. 
 
Select My Folders. 
 
We will customize our InfoView so that the reports saved in the 
Favorites folder will show when we open the window.  You have the 
option to create a view of whatever folder or report that you prefer.  
We are using the Favorites folder just as an example. 
 
My Folders is broken out and contains Favorites and Inbox sub-folders. 
 
Select the Favorites folder. 
 
Notice that the title Favorites is now in the Caption text box that is 
under the Header section of the dialogue box. 
 
Select the OK button. 
 
We have returned to the InfoView window.  We can now see the 
customized window showing the contents of the Favorites folder.  The 
title bar of this panel takes its text (Favorites in this case) from the 
Caption text box in the previous step. 
 
We will now go through another example.  We will use a template that 
allows you to view more than one frame in the InfoView window.   
 
Select the template with three horizontal columns. 
 
On the far ride side of the screen is a drop-down menu. 
 
The message currently displayed in the gray box informs us that once 
we decide to change our current InfoView template, the new template 
form will replace it.  Each time you change your template, you will 
need to begin customization of your InfoView window again.  
Customizations set on previous templates will be lost. 
 
Select the OK button. 
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A pop-up Information box, with the message, Changing layout will 
overwrite any changes you have made.  Are you sure you want to 
continue? displays on the screen. 
  
My InfoView window is displayed with three panels, each containing a 
Define Content hyperlink.  
 
Since we have three frames, we will go through the defining content 
process three times. 
 
Select the Define Content hyperlink. 
 
The Dashboard Properties window opens.  Select the Web Address text 
box and we will type in the U.S. Customs and Border Protection site 
address. 
 
The Dashboard Properties window is divided into sections that allow 
you to add a Web address or an Object.   
 
Type in the Web Address text box: http://www.cbp.gov. 
 
We will now customize an InfoView frame so that the cbp.gov Web 
address appears in the window.  The radio button next to the words 
Web Address should be darkened.  We will type cbp.gov in the Web 
Address field. 
 
Select the OK button. 
 
The OK button is in the bottom left corner of the Dashboard Properties 
window. 
 
My InfoView window is displayed with three panels. The first panel 
contains a graphical image of the cbp.gov web page. The second and 
third panels each contain a Define Content hyperlink. 
 
Notice now that the Website appears in the first frame of the InfoView 
window.  You can use the scroll bar on the right of the row to navigate 
up and down the page.   
 
Select the second Define Content hyperlink. 
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We will now define the content of the second frame by customizing a 
view of the Favorites folder.  We will follow the same steps that we 
used in the previous example. 
 
The Dashboard Properties window opens. The Dashboard Properties 
window is divided into sections that allow you to add a Web address or 
an Object. In the Object section, two expandable folders are 
displayed: My Folders and Public Folders. 
 
Select My Folders. 
 
My Folders is expanded to display the following sub-menus: Favorites 
and Inbox. 
 
Select the Favorites folder. 
 
Select the OK button. 
 
The OK button is in the bottom left corner of the Dashboard Properties 
window. 
 
My InfoView window is displayed with three panels. The first panel 
contains a graphical image of the cbp.gov web page. The second panel 
contains the Favorites folder. The third panel contains a Define 
Content hyperlink. 
 
We will now define our third frame by customizing a view of the Inbox 
folder. 
 
Select the Define Content link. 
 
The Dashboard Properties window opens. The Dashboard Properties 
window is divided into sections that allow you to add a Web address or 
an Object. In the Object section, two expandable folders are 
displayed: My Folders and Public Folders. 
 
Select My Folders. 
 
My Folders is expanded to display the following sub-menus: Favorites 
and Inbox. 
 
Select the Inbox folder. 
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Select the OK button. 
 
The OK button is in the bottom left corner of the Dashboard Properties 
window. 
 
My InfoView window is displayed with three panels. The first panel 
contains a graphical image of the cbp.gov web page. The second panel 
contains the Favorites folder. The third panel contains the user’s 
reports Inbox. There is a scroll bar along the bottom of the screen that 
allows you to view objects out of view. 
 
You are now viewing our new InfoView window that contains the three 
frames that we have customized. To keep our selections, we need to 
save them. 
 
Select the scroll bar. 
 
The save button, located in the top right-hand corner, is now visible. 
 
Select the Save button. 
 
The minimize icon, located in the top right-hand corner, is directly 
above the Save button. 
 
Minimize the window so that you can see the InfoView toolbar. 
 
Select the Minimize icon. 
 
The Home button is located on the toolbar in the top left-hand corner 
of the screen. 
 
Select the Home icon. 
 
The ACE secure data portal Reports Home page and Folders display. 
 
We have returned to the home page. 
 
 
To Summarize... 
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• You have learned how to set preferences and customize the 
InfoView feature of ACE Reports. 

 
• You have learned the purpose of and how to navigate and view 

reports through the Inbox feature. 
 
Knowledge Check Question 1 
 
The templates in My InfoView provide you with options for _________. 
 
A) Setting up the view and the number of areas that you will see in 
your InfoView. 

 
B) Saving the information to Public Folders. 

 
C) There are no templates in InfoView. 
 
The correct answer is B.  
 
 
Knowledge Check Question 2 
 
Which of the statements about InfoView is true? 
 
A) It allows you to set your preferences for viewing different features 
of ACE Reports. 

 
B) You can customize the view so that you can include important 
website pages such as  

 
C) All of the above are true. 

The correct answer is C. 
 

 
Knowledge Check 3 
 
The Favorite Folder provides users with _______________. 
 
A) A place to make changes in the data on reports. 
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B) A handy place to save and store reports for quick reference and 
review.  

 
C) There is no Inbox feature. 
 
 The correct answer is B. 
 
 
Knowledge Check 4 
 
In order to view a report in the Favorites Folder, you have to _______. 
 
A) Access Public Folders 

 
B) Access My Folders  

 
C) There is no Inbox folder. 
 
The correct answer is B.  
 
 
You have completed this lesson.  In this lesson, you learned about 
customizing InfoView and utilizing the Inbox feature of ACE Reports. 
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Lesson 4: Run Reports 
 
In Lesson 4: Identify and Run Reports, you will learn how to identify 
and differentiate between types of reports and how to sort, filter, run, 
and save a report as a Favorite. 
After completing this lesson, you will be able to: 
 

• Locate reports. 
• Run Prompted reports. 
• Sort and filter reports. 
• Save a report as a favorite. 

 
Now we will go through the steps of accessing a report. Use Public 
Folders to access the list of folders that contain reports. 
 
The ACE secure data portal Reports Home page and Folders panel is 
displayed. 
 
Select Public Folders. 
 
The Public Folders Menu displays a sub-menu that contains the 
following folders: Account Management, Account Revenue, Authorized 
Data Extract, Entry Summary, Reference, and Transactions. 
 
Public Folders is a main folder that contains sub-folders with the 
different types of reports.  The report we want to review is in the 
Account Revenue folder. 
 
Select the Account Revenue folder. 
 
The Account Revenue reports panel is displayed with 6 reports: AR-
001-7.  For this activity, emphasis will be on AR-007 - Periodic 
Statement. 
 
Select the AR-007 Periodic Statement Quickview - Broker link 
 
Please note: The name of the report is the link to open the report. 
 
The Prompts dialogue box will display when you open a Prompted 
report.  Input data into the prompts to choose the specific data you 
want to see in the report.  Notice the option to sort by Importer 
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Number, Filer Code, or District Port Code in the top section of the 
Prompts box. 
 
NOTE: Notice the green check marks beside the prompts in the report.  
They indicate that each of the items is defined, and you are not 
required to (although you may opt to) change the prompts for the 
report.  However, if there is a red arrow beside the prompt, this is an 
indication that you must first define the prompt before you can run a 
query on the report.   
 
Select District Port Code. 
 
When you select District Port Code, a list of port numbers appears in 
the box to the bottom left (within the Prompts dialogue box).   
 
We will run a Prompted report that includes all of the data for port 
code 0103 (Eastport, ME).  By selecting port 0103, we are requesting 
a report that only shows data from Eastport. 
 
NOTE: In this example, we are entering a prompt only for the specific 
District Port Code.  However, you have the option to enter additional 
prompts for filtering data in a report.  For example, you could select 
the Filer Code(s) option and filter data in the report by defining 
prompts related to filer codes.   
 
Select the 0103 item. 
 
Once you have selected the port code, move the code to the box to 
the right (within the Prompts dialogue box).  You control movement 
between the two boxes by selecting either >> or <<. 
 
Select the >> button. 
 
Notice that the District Port Code(s) box now contains the port code 
0103 and --ALL--. 
 
Since we only want data from the 0103 port code, we need to remove 
the --ALL--. 
 
Select the --ALL—item. 
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The << arrow button will allow us to remove the --ALL-- from the 
District Port Code(s) box.   
 
Select the << button 
 
Only Value 0103 remains in the District Port (s) box. 
 
Now we are prepared to run the report that contains only District Port 
Code 0103 data. 
 
The run Query button is located in the upper right-hand side of the 
Prompts dialogue box. 
 
Select the Run Query button. 
 
The AR-007 Periodic Statement Quickview – Broker report is now 
displayed.  On the right hand side, Importer Number and Filer Code 
have a value of ALL, and the District Port Codes value is 103. 
 
You have succeeded in running this report! 
 
Let’s clear the Workspace panel. 
 
Select Home button. 
 
The ACE secure data portal Reports Home page and Folders panel is 
displayed. The Folders panel contains two main folders: My Folders 
and Public Folders. The Public Folders Menu displays a sub-menu that 
contains the following folders: Account Management, Account 
Revenue, Authorized Data Extract, Entry Summary, Reference, and 
Transactions. Each of these sub-folders are expandable. 
 
You will notice that within Public Folders nested folders exist.  You will 
go through several folders to get to the specific report we will run. 
 
Select the Account Management folder. 
 
The Account Management sub-menu displays with the following 
options: Account Profile, Aggregate Reports, Broker Permits, 
Declarations, Detailed Reports, and Quick Views. 
 
Select the Aggregate Reports folder. 
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We want to access Cargo Exams Reports, located in the Cargo Exam 
folder. 
 
Aggregate Reports contains the following sub-menus: Cargo Entry, 
Cargo Exam, Entry Summary, ES Compliance. 
 
Select the Cargo Exam folder. 
 
Once again, this view provides us with a list of all the reports in the 
folder. 
 
The Cargo Exams reports panel displays.  Within this panel there is 
only one report: Cargo Exams Reports – Trade. The title of this report 
is also a hyperlink to activate the report. Headers in this panel include: 
Title, Last Run, Type, Owner, and Instances. 
 
Select Cargo Exams Reports – Trade. 
 
The AR-037 Summary of Nbr of Cargo Exams by Month Report – Trade 
is displayed and contains the following data columns: HTS Nbr, HTS 
Description, Nbr of Entry Exams, Nbr of line Exams, Trade Descrep 
QTY, ADD CVD Ind, Class Descrip, Forced Labor Ind. There is a scroll 
bar on the side of this report. 
 
As demonstrated in the previous report, the Prompts box will require 
that you input the parameters (such as date ranges) related to the 
data that you want to view in the report.  For this example report, 
although the steps for completing the Prompts box are not shown, 
they were completed and the current view is of the report data based 
on the parameters that were set in the Prompts box.   
 
We will begin with sorting.  Let's scroll down a bit so that we can see 
more of the report. 
 
Scroll down. 
 
We must select the column we wish to sort.  This is done by right 
clicking in the desired column to display the menu.  We will right click 
for you. 
 
Select the Nbr of Entry Exams column. 
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A menu displays over the Nbr of Entry Exams column, containing the 
following options: Set as section, Insert, Format, Quick Filter, Turn 
Table to.., Swap axis, Break, Sort, Calculation, and Remove. 
 
Select Sort.  
 
Selecting Sort activates a drop-down menu with the following options: 
None, Ascending, Descending, Custom sort, Remove Sorts, and 
Properties. 
 
Please note: When beginning a sort, verify that None is checked from 
the drop-down list to ensure that the column is not already sorted. 
 
Select Ascending. 
 
The numbers in the highlighted column now appear in ascending 
order.  Our sorting has been successful!  
 
The course now displays the ES Compliance- Trade Report. There is a 
scroll bar on the right side of this report. 
 
We have navigated to the ES Compliance- Trade Report in ACE Reports 
to demonstrate the Custom Sort feature. 
 
We will need to scroll down to reveal most of the report. 
 
Select the scroll bar. 
 
ES Compliance– Trade Report is displayed, and the Consignee column 
is highlighted. 
 
Notice that the sort looks somewhat strange, and is not exactly in 
numerical order.  1000, for example, comes between 0 and 100. 
 
In the Consignee Name column, the information is text, rather than 
numbers.  It is being sorted alphabetically.  When numbers are sorted 
alphabetically, the values aren't considered.  Instead, the individual 
digits are looked at in the order of 0, 1, 2, 3, 4, 5, 6, 7, 8, 9.  Thus, 
100 comes before 11 alphabetically because the second digit in 100 is 
a 0 and the second digit in 11 is a 1 and 0 comes before 1. 
 
To fix this, we will use the Custom Sort feature. 
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Select the Consignee Name column. 
 
Selecting the Consignee Name column activates a menu, which 
displays directly over the column. The menu contains the following 
options: Set as section, Insert, Format, Quick Filter, Turn Table to.., 
Swap axis, Break, Sort, Calculation, and Remove. 
 
Select Sort. 
 
Selecting Sort activates a drop-down menu with the following options: 
None, Ascending, Descending, Custom sort, Remove Sorts, and 
Properties. 
 
Select Custom sort...  
 
The Custom Sort pop-up window displays with various number values 
available to select.  These values are contained in a list titled Reorder 
values in the list. There are two arrows to the right of the list, one 
pointing up and one pointing down. Once the user selects the value, 
OK, Apply and Cancel buttons are available. 
 
The custom sort feature will sort the information based on the order of 
the values in the list.  We will move the values so that the end result is 
an ascending numerical list. 
 
Select 101. 
 
The upward arrow will move the selected item by one place. You may 
need to select the arrow multiple times to relocate the number to the 
desired location. In this example, we will only move the number 
upward by one place. 
 
Select the Upward Arrow. 
 
We have moved the rest of the values for you. The list is now in 
ascending numerical order. Select OK to continue. 
 
The ACE secure data portal, ES Compliance– Trade Report Consignee 
column has now been sorted in numeric order. 
 
The ACE secure data portal, ES Compliance– Trade Report consignee 
column is highlighted. 
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You've now finished custom sorting a report. Let's take a quick look at 
how to remove a sort.  
 
Select the Consignee Name column. 
 
Selecting the Consignee Name column activates a menu, which 
displays directly over the column. The menu contains the following 
options: Set as section, Insert, Format, Quick Filter, Turn Table to.., 
Swap axis, Break, Sort, Calculation, and Remove. 
 
Select Sort. 
 
Selecting Sort activates a drop-down menu with the following options: 
None, Ascending, Descending, Custom sort, Remove Sorts, and 
Properties. 
 
The Remove Sorts feature allows you to undo or remove the sorts that 
you have requested on the report.   
 
Select Remove sorts. 
 
The Consignee Nbr Column of the ES Compliance– Trade Report has 
been unsorted. 
 
All sorts have been removed and the report reflects the same order as 
when we opened it.   
 
Let's take a look at how to filter a report. 
 
The ACE secure data portal, Cargo Exams Report– Trade report is 
displayed. The Nbr of Line Exams column is highlighted. Selecting this 
column has activated a menu, which displays directly over the column. 
The menu contains the following options: Set as section, Insert, 
Format, Quick Filter, Turn Table to.., Swap axis, Break, Sort, 
Calculation, and Remove. 
 
You will notice that there is a Quick Filter (and Sorting) option on the 
grey menu bar at the top of the report.  You can take this route as 
well, but it is faster to right click in the column you want to filter. 
 
Select Quick Filter...  
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The Quick Filter dialogue box should now be in view.  Notice the grey 
box located in the blue area of the Quick Filter dialogue box.  It 
contains the name of the column that you have selected for filtering.  
The drop-down menu arrow next to it allows you to select your desired 
criteria. The default is Greater than which is what we will be using. 
 
Select the Quick Filter text box. 
 
The Quick Filter dialogue box displays and the number 200 is typed in 
as the basis for filtering. 
 
Once the value you want to use as a basis for filtering has been 
entered, move it to the blank box in the blue area of the Quick Filter 
dialogue box. Use the forward arrow button to do this. 
 
Select the >> 
 
The 200 quantity is now moved below the Entry Line Exam Qty button 
in a text box. There are two buttons in the lower right corner of the 
Quick Filter dialogue box, OK and Cancel. 
 
You have now set the criteria for filtering.  We can now accept the 
filter settings and close the Quick Filter dialogue box. 
 
Select the OK button. 
 
The report displays only numbers greater than 200 in the Nbr of Line 
Exams column.  
 
Your data has been successfully filtered!  Notice that only numbers 
that are greater than or equal to 200 now appear in the column. 
 
We will now learn how to save a report as a Favorite.  This allows you 
to easily access a customized report. 
 
Select the scroll bar. 
 
The top of the Cargo Exams Report– Trade report is displayed. This 
view includes a toolbar at the top of the screen. To the far left side of 
the toolbar there is a Document drop-down menu. 
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We will access the Save option by selecting the Document drop-down 
menu. 
 
Select the Document drop-down menu. 
 
The Document Drop-down menu has the following options: Close, 
Save as, Save to my computer as, and Properties. 
 
A drop-down menu displays. 
 
Select Save as. 
 
The Save Document window displays, and the following title was typed 
in the Title textbox: My Favorite Cargo Exams Report.  A location 
menu containing folders and sub-folders is displayed on the bottom of 
the screen.   
 
The Favorites folder is located in My Folders.   
 
Select My Folders. 
 
After selecting My Folders, the sub-folder, Favorites is now available. 
 
Once you select the Favorites folder, you are requesting that your 
newly named report is placed in this location.   
 
Select the Favorites folder 
 
Scroll down. 
 
After scrolling, OK and Cancel buttons are displayed in the lower right 
corner of the screen. 
 
Once you select OK, your report will be saved to the Favorites folder.  
This page will then close, and you will be taken back to the report. 
 
Select the OK button. 
 
The screen displays the Folders pane on the left-hand of the screen 
and the right side displays the My Favorite Cargo Exam Report. The 
Home icon is in the upper left corner of the screen, on the ACE Reports 
toolbar. 
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We have successfully saved this report in the Favorites folder!  
 
Your next step is to learn how to access a saved report from your 
Favorites folder. 
 
Select the Home icon. 
 
The ACE secure data portal Reports Home page and Folders panel is 
displayed.  
 
We are now back at the home view.  To find the report that we saved 
as a favorite, we must first access My Folders. 
 
Select My Folders. 
 
My Folders expands to display the Favorites and Inbox folders. 
 
Select the Favorites folder. 
 
Selecting the Favorites folder brings you to this view of all reports that 
have been saved as a favorite.  We will now look for the report we 
saved as My Favorite Cargo Exams. 
 
Select the My Favorite Cargo Exams Report link. 
 
My Favorite Cargo Exams Report is now open.  You have successfully 
saved and accessed a favorite report! 
 
Now, let's review what we have learned.   
 
My Favorite Cargo Exam report is now displayed. 
 
To Summarize... 
You have learned how to identify, access, filter, sort and run ACE 
Reports. 
 

• You have learned how to customize reports according to your 
preferences and save them as favorites that you can access from 
the Favorites folder.   

 
Knowledge Check 1 
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Files that I save as Favorites are located under __________________. 
 
A) My Folders 
 
B) Public Folders  

 
C) None of the above. 
 
The correct answer is A.  

 
 
Knowledge Check 2 
 
In order to Sort or Filter a column in a Report, you must 
__________________. 
 
A) Draw a circle around the column you want to sort or filter. 

 
B) Highlight the column you want to sort or filter.  

 
C) None of the above. 
 
The correct answer is B.  
 
 
Knowledge Check 3 
 
If I customize a report the way I want to view it when opened, then I 
should save it in __________________. 
 
A) Public Folders 

 
B) My Favorites Folder  

 
C) None of the above. 
 
The correct answer is B.  
You have completed this lesson.  In this lesson, you learned about 
identifying and running reports. 
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Lesson 5: Manipulate Reports 
 
In Lesson 5: Manipulating Reports, you will learn about the various 
features that allow you to manipulate reports according to your 
preferences.   
 
After completing this lesson, you will be able to: 
 

• Change report view and formatting.   
• Perform calculations on report data. 
• View alternate charts and tables. 
• Customize a report for your personal use. 

 
The ES Compliance – Trade report and headers are displayed on the 
screen. 
 
We have logged into the ACE Portal, launched the InfoView interface 
and run the ES Compliance report. You may notice the tabs on the 
bottom of the screen.  Some reports consist of a series of detailed 
reports to allow the user to view a large amount of data in a relatively 
convenient package. 
 
We will need to scroll down to see the details of the report. 
 
Scroll down. 
 
The ES Compliance – Trade report data is displayed on the screen.  
The number 1 in the tool bar indicates the first page of the report is 
displayed.  The report contains the following visible headers: HTS Nbr, 
HTS Description, Nbr of Lines Rvwd, Nbr of Entry Descrip, ADD 
Discrep, Assist Discrep, and Class Discrip.  The bottom of the report 
contains the following buttons: POE Codes, IR Nbrs, Filer Codes, HTS 
Nbrs, Consignee Nbrs, Entry Type Codes, COO Codes, and Mfr Codes. 
 
You're now on page view, which allows you to view a report by each 
page. Take a close look at the toolbar across the top of the Workspace 
panel. On the right-hand side of the toolbar, there is a white box 
containing '1'. This indicates which page of the report we are viewing.  
Using the arrows to the left and right of this number allows you to 
navigate the report by page. 
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Select ►l next to the page number. 
 
The ES Compliance – Trade report data is displayed on the screen.  
The number 11 in the toolbar indicates the eleventh page of the report 
is displayed. There is a View menu on the left side of the toolbar.  
 
The /11 indicates the total number of pages in the report.   
 
Also, notice in the HTS Nbr column, the numbers are in blue text and 
are underlined.   The blue text and underlining indicate that the text is 
hyperlinked.  If you select any numbers or text that are hyperlinked, 
more detailed information will appear.   
 
There are 2 other views we use to view reports: Draft and PDF.  Let's 
take a look at how to change the view. 
 
Select the View drop-down menu. 
 
The View drop-down menu displays, containing the following options: 
Page mode, Draft mode, PDF mode, Left panel Status Bar, and 
Toolbars. 
 
Select Draft mode. 
 
The ACE secure data portal, ES Compliance – Trade report displays as 
one page. 
 
The report is now seen in Draft view and shows 1 page instead of 11 
pages (as noted earlier). 
 
Select the View drop-down menu 
 
The View drop-down menu displays, containing the following options: 
Page mode, Draft mode, PDF mode, Left panel Status Bar, and 
Toolbars. 
 
Select PDF mode. 
 
The report now displays in PDF format. In the top left corner of the 
screen there are two buttons, View in HTML format and Status Bar. 
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Select View in HTML format. 
 
The report is now displayed in HTML format. The View drop-down 
menu is located in the top left corner of the screen. 
 
One other option we have for navigating a document is using the 
Navigation Map.  The Navigation Map can be located in the Left Panel 
when that panel is visible.  To reveal the Left Panel, select that choice 
from the View menu. 
 
Select the View drop-down menu 
 
The View drop-down menu displays, containing the following options: 
Page mode, Draft mode, PDF mode, Left panel Status Bar, and 
Toolbars. 
 
Select Left Panel. 
 
The screen displays the left panel bar and contains the Document 
Summary drop-down menu, Print, General Document Properties and 
Prompts options. 
 
Select the drop-down menu arrow. 
 
The Left Panel drop-down menu contains the following options: 
Document Summary, Data Summary, Chart and Table Types, Objects, 
Document Structure and Filters, Navigation Map, User Prompt Input, 
and Find. 
 
Select Navigation Map. 
 
Selecting Navigation Map changed the contents of the Left Panel, to 
include elements associated with the report’s navigation. There is now 
a red arrow to the left of the Left Panel drop-down menu. 
 
Before we move on to formatting options, let's hide the Left Panel by 
selecting the arrow to the left of it. 
 
Select the arrow to the left of the Navigation Map drop-down menu. 
 
Selecting the red arrow removes the Left Panel and displays just the 
report. 
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Next, we will take a look at calculations you can add to a report. 
 
We are starting in the Summary of Team Reviews by Month tab of the 
ES Compliance - Trade Report. Scroll down to scroll down and view the 
report. 
 
Scroll down. 
 
Scrolling down displays the data and header for this report. The 
header includes the following columns: Year-Month, Nbr of Lines 
Rvwd, Nbr of Entry Descrip, ADD Discrep, Assist Discrep, Class Discrip, 
Clerical Error Descrip, CVD Descrip, Country of Origin Descrip, 
Currency Decsrip, and Discount Descrip. 
 
To add calculations to a column, select the column you want and right 
select to reveal the menu.  We will right select for you in this example. 
 
Select a number in the Nbr of Entries Rvwd column. 
 
The Nbr of Entries Rvwd column is highlighted and a menu with the 
following sub-menu options displays over the column: Set as section, 
Insert, Format, Quick Filter, Turn table to, Swap axis, Break, Sort, 
Calculate, and Remove. 
 
Select Calculation. 
 
The Calculation sub-menu displays with the following options: Sum, 
Count Average, Min, Max, Percentage. 
 
Select Count. 
 
The ES Compliance – Trade report displays with an option to scroll 
down and display the rest of the report. 
 
Scroll down. 
 
The bottom of the report is now displayed. 
 
Now we see a count of the months listed in this report. 
 
The report and the Nbr of Entries Rvwd column is displayed with a 
count total of 18. 
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Charts are a graphical way to look at the numerical data in a list.  If 
you have a list of data, it can be difficult to see what that data is 
telling you just by looking at the numbers.  If you use a chart, you can 
more easily compare different values because they are represented 
graphically.   
 
There are several terms you should know about charts:  
 
A Data Point is a specific graphic on a chart that represents a number.  
On the chart on the left, the data points are each of the individual 
bars. 
 
A Category is a grouping of data points that are related.  In this chart, 
the categories are the quarters and are noted on the bottom. 
 
A Series is another grouping of related data points.  In most charts a 
series is one color of data points.  In this chart, the series are denoted 
by the colors of the bars, and are East, North, South, and West. 
 
An Axis is either a vertical or horizontal line on the edge of a chart that 
shows either categories, series, or values.  There are three possible 
axes: X (usually horizontal, usually Category), Y (Usually Vertical, 
usually values), and Z (Usually horizontal, usually series, only on 3D 
charts). 
 
The Legend is the list on the chart that tells you what each color 
means.  You will find the series listed on the legend. 
 
The ACE AR-002 Aged report is displayed. The Left Panel drop-down 
menu displays Document Summary. Beneath this menu are sections 
titled Print, General Document Properties and Prompts options. 
 
We have entered the Draft View of this report and revealed the left 
panel. Select the drop-down menu to change Document Summary to 
Chart and Table Types. 
 
Select the Document Summary drop-down menu 
 
The Left Panel (or Document Summary) drop-down menu contains the 
following options: Document Summary, Data Summary, Chart and 
Table Types, Objects, Document Structure and Filters, Navigation Map, 
User Prompt Input, and Find.   
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Select Chart and Table Types. 
 
Selecting Chart and Table Types displays numerous report element 
options, including: Table Elements, Chart Elements and Cells.  Chart 
Elements contains the following options: Bar, Line, Area, Pie and Area 
charts. 
 
There are several types of charts to choose from.  We will expand the 
Bar Charts to see the different bar charts available. 
 
Select the + next to Bar Charts. 
 
Bar Chart has expanded to display the following options: Vertical 
Grouped, Horizontal Grouped, Vertical Stacked, Horizontal Stacked, 
Vertical Percent, Horizontal Percent, and 3D bar. 
 
At this time, we will add a Vertical Grouped Bar chart to this report.   
 
Select Vertical Grouped. 
 
We want to put the chart at the bottom of the report, so we will need 
to scroll down. 
 
Scroll down. 
 
Select outside the table in the area where you wish to put the chart. 
 
The Left Panel includes an active Insert button directly below the Left 
Panel drop-down menu. 
 
Select Insert to insert the chart. 
 
A Format Chart dialog box displays, containing the following tabs:  
General, Appearance, Layout Properties and Pivot, which is the 
displayed.  Pivot contains a listing of Available Objects, as well as 
boxes for adding content to the chart’s Y-Axis, Z Axis, and/or X-Axis 
options.  To select the appropriate axis, you must first select the radio 
button associated with the desired axis. There are double arrow 
buttons (>> and <<) between the listing of Available Objects and the 
Axis boxes. These move selected objects into the selected axis box. 
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The Format Chart dialog box appears, showing the Pivot tab. 
 
Use District Port Code as the category for this report and select it for 
the X-axis. 
 
Select District Port Code 
 
Now select the right arrow button to add District Port Code to the X-
axis. 
 
District Port Code has now been placed in the X-Axis window. 
 
Remember, objects in the Available Objects list marked with blue 
squares are text values.  The objects marked with pink circles are 
numbers.  You will need a numerical value for the Y-axis. In the 
following example, we are only using two numerical objects; however, 
you can use any or all numerical objects in the Y-axis.  
 
Select the Y-axis radio button. 
 
The radio button next to the Y-axis window is now filled in. 
 
Now, scroll down to the bottom of the Available Objects list. 
 
Select each data point, and select the right arrow to add it to the list. 
 
Select Entry Toll Amt. 
 
Select the right arrow button. 
 
Entry Toll Amt is now placed in the Y-axis window. 
 
Let’s look at the Appearance tab. 
 
Select the Appearance tab. 
 
The Appearance tab contains a graphic view of a bar graph with the 
following buttons: Y-axis (Labels and Values) and X-axis (Labels and 
Values). The user now has the ability to set values for each axis. 
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Let's take a look at some of the options we have to customize the 
chart. 
 
Select Values under the Y Axis heading. 
 
When the Values option is selected, you can set the Maximum and 
Minimum value on the axis. Now we will view the General tab and 
change some of the general options. 
 
Select the General tab. 
 
The General tab displays the following sections: Name, Width, Display, 
Chart Borders and Background Color.   
 
In the General tab, we can change the size of the chart and hide or 
display some options.  Here, we will set the dimensions of the chart to 
3" x 5", remove the Y axis label, and add the Legend. 
 
Select the Name text box. 
 
Chart 1 is typed in the Name text box. 
 
Select Width and change it to 5. 
 
The Width box is highlighted in the format chart window and is 
changed to 5. 
 
Select Height and change it to 3. 
 
The Height box is highlighted in the format chart window and is 
changed to 3. 
 
De-select the Show Y Axis label checkbox. 
 
The Show Y Axis checkbox located under display is de-selected. 
 
Select the Show legend checkbox. 
 
The Show Legend checkbox located under display is selected. 
 
Select OK to view the chart. 
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The following has been selected to view: Name: Chart 1, Width: 5 
inches, Height: 3 Inches.  Display, the following are checked: Show 
Chart when empty, Show X Axis, 3d look, and Show legend.  Charter 
borders are set to None. 
 
Once you select okay, you will be returned back to the report.  Your 
table should be at the bottom of the report where it was indicated to 
insert the table. 
 
Scroll down. 
 
The Aged Entry Data report displays, containing the following column 
headers: Filer Name, Importer Name, Port Code, Creation Date, and 
Entry Totl Amt. The column headers are displayed horizontally across 
the top of the table. 
 
We will now take a look at how to view tables. There are several ways 
to view tables in a report.  They can be set up as vertical, horizontal, 
or form-like.   
 
Select the Filer Name column. 
 
The Left Panel is displayed.  The Left Panel drop-down menu is set for  
Chart and Table Types.  Table Elements contain the following options: 
Horizontal Table, Vertical Table, Crosstab, and Form. 
 
Select the type of table you want to use.  In this case, we will use a 
Horizontal Table. 
 
Select Horizontal Table. 
 
The Turn to option is now available in the left panel under the Left 
Panel drop-down menu. 
 
In order to change an existing table to another layout, once the table 
and layout are selected, select Turn to. 
 
Select the Turn to option. 
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The report is now displayed horizontally and not vertically.  The first 
column contains the headings Filer Name, Importer Name, Port Code, 
Creation Code, and Entry Totl Amt. 
 
Now this table is arranged horizontally in rows, rather than vertically in 
columns.  Let’s take a look at how to change the table to a form 
layout. 
 
Select the Filer Name row 
 
The first row associated with the Filer Code is now highlighted. The 
Left Panel drop-down menu is set for  Chart and Table Types.  Table 
Elements contain the following options: Horizontal Table, Vertical 
Table, Crosstab, and Form. 
 
Select Form. 
 
The Turn to option is now available in the left panel under the Left 
Panel drop-down menu. 
 
Select the Turn to option. 
 
The form layout shows each entry individually.  This can be useful if 
you need to quickly see information for one particular entry.  You can 
scroll through the table to see some of the data. 
 
You are also able to turn the table into a chart, instead of adding a 
chart element to the report.  This is accomplished by selecting the 
table in the report, selecting a chart type and selecting the Turn to 
button in the left panel.  When working with reports which contain a 
large amount of data, it is advisable to add a chart element to the 
report instead of changing the table layout to a chart. 
 
The AR-002 Aged Entry Data report is now displayed and has the 
following headers: Filer Name, Importer Name, Port Code, Creation 
Code, and Entry Totl Amt contain data.  The Left Panel drop-down 
menu is set to Document Summary. 
 
We have reverted back to a fresh copy of the AR-002 report with no 
customizations.  Now we're going to take a look at how to add and 
remove columns displayed in the report.  
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To begin, we must navigate the left panel to the Available Objects 
section. 
 
Select the drop-down menu. 
 
The Left Panel drop-down menu contains the following options: 
Document Summary, Data Summary, Chart and Table Types, Objects, 
Document Structure and Filters, Navigation Map, User Prompt Input, 
and Find.   
 
Select Available Objects  
 
Available Objects display options in the left panel.  The report is 
displayed on the right side of the screen.   
 
You must first select the location for adding the column in the report.  
To do this, select a column next to the location of where the new 
column will be inserted.  Right select to display the menu. 
 
Select the Importer Name column. 
 
The Importer Name column is highlighted and displays a menu directly 
over the column that contains the following options: Insert, Format, 
Quick Filter, Turn table to, Break, Sort, Calculate, and Remove. 
 
Select Insert. 
 
The insert menu displays, containing two options: New row and New 
column. 
 
Select New Column. 
 
This next menu choice will determine if the new column is to the right 
or left of the selected column.  Choose the Right option. 
 
Select Right. 
 
We see a blank column has been inserted to the right of the Importer 
Name column.  Next, we must determine what data will display in this 
column.  To accomplish this, we need to find the available object we 
wish to put in this column from the list. 
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Select Carrier Name  
 
Carrier Name is in the list of Available Objects in the report’s Left 
Panel. 
 
To add the data we selected to the blank column, we must drag it from 
the Available Objects list to the desired location.  In this example, we 
will drag the object for you. 
 
Select the empty column. 
 
Now we can see the Carrier Name to the left of Importer Name in the 
report. An alternate way of adding an object to a report is to drag the 
object to the report without adding a column.   
 
Our next example will show you how to remove a column from a 
report. 
 
Select the Creation Date column 
 
The Creation Date column is highlighted and displays a menu directly 
over the column that contains the following options: Insert, Format, 
Quick Filter, Turn table to, Break, Sort, Calculate, and Remove. 
 
Select Remove. 
 
A Remove sub-menu with the following options is now displayed: Row, 
Column, and Table. 
 
Select Column. 
 
The Creation Date column has been removed from the report. 
 
We have now successfully added and removed a column of the report. 
 
After having formatted, added charts and modified the table layout of 
the report, you may want the option to return to reports that you have 
customized using these or other features. To review how to save a 
report as a favorite, please see Lesson 4. 
 
Congratulations! You have completed Lesson 5. 
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To Summarize... 

• You learned to change report views and formatting features.   
 

• You learned how to create charts and tables and use calculations 
in manipulating reports.   

 
• You learned how to customize a report for your personal use. 

 
Knowledge Check 1 
 
Which of the following views is not interactive? 
 
A) Draft Mode 

 
B) Page Mode 

 
C) PDF Mode 

 
D) Both A and B 
 
The correct answer is C.  
 
 
Knowledge Check 2 
 
Which of the following elements can have their formatting changed? 
 
A) Text 

 
B) Cell Backgrounds 

 
C) Cell Borders 

 
D) All of the Above 
 
The correct answer is D. 
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Knowledge Check 3 
 
Which of the following is an available calculation? 
 
A) Data 

 
B) Sum 
 
C) Chart 

 
D) Table 
 
The correct answer is B.  
 
 
Knowledge Check 4 
 
Which type of table shows each entry in separate, individual blocks? 
 
A) Horizontal 

 
B) Vertical 
 
C) Crosstab 

 
D) Form 
 
The correct answer is D 
 
 
You have completed this lesson.  In this lesson, you learned about the 
manipulation of reports. 
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Lesson 6: Schedule Reports 
 
In Lesson 6: Schedule Reports, you will learn about scheduling and re-
scheduling reports and deleting scheduled instances of a report.  You 
will also find out how to view the different instances of a report. 
 
After completing this lesson, you will be able to: 
 

• Schedule reports and change scheduling options. 
• Reschedule a report. 
• Delete a report from the schedule. 
• View report history. 

 
The ACE secure data portal divided into 2 panels.  On the left side are 
Folders with Home and My Folders, which also displays sub-folders.  
The right side displays various ACE reports with the following options:  
History, Schedule, Modify and Properties. 
 
For this example of scheduling a report, we are going to use the AM-
012 Report. 
 
Select the Schedule link. 
 
The Schedule panel displays, and lists various objects for the AM-012 
Summary POE report, including When and Format options.  When has 
a drop-down menu on when to run the report and has a default of 
Now. 
 
Notice that the Instance title is automatically filled with the report 
name. The When category is automatically expanded to reveal a drop-
down menu.  Run object will default to Now.  Let's change this 
selection. 
 
Select the Run object drop-down menu 
 
The When drop-down menu has the following options: Now, Once, 
Hourly, Daily, Weekly, Monthly, Nth day of the month. 1st Monday of 
the Month, Last day of the Month, X day of the Nth day of the Month, 
and Calendar. 
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Select the Last Day of Month 
 
ACE now displays start and end time drop-down menus to schedule 
the start and end time of the report. 
 
Notice that the remainder of the When category has changed to 
include a Start and End Time Selection.  The Start time is the time and 
date you would like this report to run on a recurring basis.  The End 
time is the time and date that you no longer wish to have the report 
run on a scheduled basis.  
 
Note: It is a good idea to schedule a report to run outside of normal 
business hours; otherwise it may take a large amount of time to pull 
the report. 
 
Select the Start Time hour drop-down menu. 
 
The start time drop-down menu displays numbers 1-12. 
 
Select 11. 
 
The start time has been updated to 11 and the Calendar icon, located 
next to the date text box is highlighted. 
 
Select the calendar icon. 
 
The Calendar pop up window appears with a default month and year of 
February 2007 
 
Select the Month drop-down menu. 
 
The Month pop-up window appears and March is highlighted. 
 
Select March. 
 
The Calendar pop up window is set to March 2007 and the number 1 is 
highlighted. 
 
Select 1. 
 
The Start Time displays 11:15:00 PM 03/01/2007 
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Now that we've selected when we want the scheduled report to run, 
we also need to specify in what format we would like to have the 
report. 
 
Select the + next to Format  
 
When selected , the + Format has a default of Web intelligence in the 
text box with a drop-down menu for additional options. 
 
Select the Format drop-down menu. 
 
Format options include Microsoft excel and Adobe Acrobat. 
 
While the format default is Web Intelligence, we can change this to 
have the report appear in a Microsoft Excel or Adobe Acrobat format. 
 
Select the Microsoft Excel item. 
 
Microsoft Excel now appears in the Format text box.  The Prompts 
section has a Modify Values button that can be changed. 
 
Select the Modify values button 
 
The Prompts pop-up window displays and contains the following 
queries: Broker Code(s), District Port Code (s), Importer Number (s), 
Include Entries with no Entry Date, and Entry Report Creation Date 
(Begin). 
 
The Modify Values Prompt box appears.  It is required to define the 
prompts that have the red arrow beside them.  For this particular 
report, you will need to complete the Entry Begin and End Date of that 
you would like to see when you run the report. 
 
Scroll down. 
 
Scroll down displays other options available in the Prompts window: 
Entry Report Creation Date (End), Entry Report Entry Date (Begin) and 
Entry Report Entry Date (End). 
 
Select the Entry Report Entry Date (Begin) link. 
 



Web-based Training Guide for  Module 2, Lesson 6 
ACE Reports for Trade 

53 

Entry Report Entry Date (Begin) text box displays with the Calendar 
icon located to the right of the text box. 
 
Select the calendar icon. 
 
The Calendar pop-up window displays with a default of March 2008.  
The top of the box has arrows that allow for a previous or next year 
and month to be chosen.  
 
Select the Previous Year arrow. 
 
The calendar now displays March 2007. 
 
Select the Next Month arrow. 
 
The Calendar now displays April, 2007. 
 
Select April 1, 2007. 
 
Entry Report Entry Date (Begin) text box is now set to April 1, 2007. 
 
Select the Entry Report Entry Date (End) link. 
 
Entry Report Entry Date (End) text box is now highlighted 
 
Select the Calendar icon. 
 
The Calendar pop-up window displays with a default of April 2007.  
The top of the box has arrows that allow for a previous or next year 
and month to be chosen.  
 
Select April 30, 2007. 
 
The Prompts dialogue box displays and has April 30, 2007 in the Entry 
Report Entry Date (End) text box. 
 
Select the Apply button. 
 
The Schedule panel displays and have the following defaults: Instance 
Title: AM-012 Summary of POE, Run Object: last day of the month.  
Start time: 11:15 pm beginning on 3/1/2007, End time: 5:15 pm 
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ending on 2/11/2017, Format: Excel.  Modify values include Entry 
Report Creation Date (begin: 1/1/2000- and End 12/31/2020. 
 
Select the Schedule button. 
 
The History section of the report is now displayed and contains the 
following options: Recurring and Reschedule. 
 
We now see the History section for this report. In the History link, you 
can Pause, Resume and Delete scheduled report instances.  You can 
also learn more about the status of an instance and reschedule a 
report. The History section will list all instances of a report that have 
been run or attempted to run. It also shows any scheduled instances 
for the future. 
 
To reschedule a report, you would select the Reschedule link. 
 
Select the Reschedule option. 
 
The Schedule panel displays, and lists various objects for the AM-012 
Summary POE report, including When and Format options. When has a 
default of Last Day of the Month. 
 
You are now revisiting the schedule page for this scheduled report. 
Notice that it looks nearly identical to the screen we saw when 
originally scheduling this report, but there is one difference.  Below the 
instance title, you now have the option to replace the existing schedule 
or to create a new scheduled instance.   
 
Normally, you would want to replace the existing schedule, but for this 
example, we are going to create a new schedule. 
 
First, we need to make our changes. 
 
Select the + next to Format box. 
 
When selected, the + Format has a default of Microsoft Excel in the 
text box with a drop-down menu for additional options. 
 
 
Select the Format drop-down menu. 
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The Format drop-down list appears showing Web Intelligence, 
Microsoft Excel and Adobe Acrobat. 
 
Select the Adobe Acrobat item. 
 
The Format drop-down box now shows Adobe Acrobat. 
 
We have now changed the format of the report to Adobe Acrobat and 
we're ready to save those changes. 
 
Select the Schedule button. 
 
The History panel displays with 2 schedules.  Each schedule has a 
check box unchecked along with the options to Pause, Resume or 
Delete. 
 
We are returned to the History page. Notice that there are 2 instances 
of the report scheduled.  We are going to delete the originally 
scheduled instance. 
 
Select the check box. 
 
The second instance now has a checkmark in its check box. 
 
Select Delete. 
 
The History panel displays with 1 schedule.  The schedule line has a 
check box unchecked along with the options to Pause, Resume or 
Delete. 
 
You've now learned how to Delete a Scheduled Report. 
 
Let's take a look at the status of this report. 
 
Select the Recurring option. 
 
The History panel displays with 1 schedule.  The schedule line has a 
check box unchecked along with the options to Pause, Resume or 
Delete. 
 
In the Status section of this report, you are able to see: 
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• Status 
• Destination 
• Recurrence Type 
• Creation Time 
• Next Run Time 

 
Congratulations!  You've now learned how to schedule, reschedule and 
delete scheduled reports. 
 
 
To Summarize... 
 

• You learned how to schedule and reschedule a recurring report 
instance. 

 
• You also learned how to delete scheduled instances and view the 

report history. 
 
Knowledge Check 1 
 
A report can be scheduled to run ______________. 
 
A) every three months 

 
B) on the last day of the month 

 
C) on the 15th of the month  
 
D) Both B & C 
 
The correct answer is D. 
 

 
Knowledge Check 2 
 
To reschedule a recurring report, you would click ______________. 
 
A) History Link 

 
B) Schedule link 
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C) Both A & B  
 
D) None of the above 
 
The correct answer is A.  

 
 
Knowledge Check 3 
 
You are in the Public Folder looking at a list of reports in you 
Workspace panel. You wish to delete an instance of a report that is 
scheduled to run on a regular basis. To find the option to delete this 
scheduled instance, you would first select what? 
 
A) History Link 

 
B) Schedule link 

 
C) Properties link  
 
D) Modify link 
 
 The correct answer is A.  

 
 
Knowledge Check 4 
 
Viewing the report history allows you to __________. 
 
A) view all instance of a report 

 
B) change the report prompts 

 
C) drill up or down in a report  
 
D) filter the report 

 
The correct answer is A.  
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You have completed this lesson.  In this lesson, you learned about 
scheduling and re-scheduling reports and deleting scheduled instances 
of a report.  You also learned how to view the different instances of a 
report. 
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Lesson 7: Print and Export Reports 
 
 
In Topic 7: Print and Export Reports, you will learn how to print 
reports, customize print settings and export reports using two different 
formats. 
 
After completing this topic, you will be able to: 
 

• Print report data. 
• Export report data to a Microsoft Excel format. 
• Export report data to a PDF format. 

 
The AM-10 Summary of HTS Number by Value Report is displayed on 
the screen.  Menu options include: Document, View, Insert drop-down 
menus, and Find. 
 
You have already logged into the ACE portal, launched InfoView and 
brought up a report. To print a report in portrait orientation, we need 
to find the print report option.  This is located in the View menu. 
 
Select the View drop-down menu 
 
The View drop-down menu has the following options: Page mode, 
Draft mode, PDF mode, left panel, and Toolbar submenu. 
 
The View options display. Opening the report in PDF mode will allow us 
to see the report in a printable format. 
 
Select the PDF mode. 
 
The AM-10 Summary of HTS Number by Value Report is displayed in 
PDF format. 
 
The Adobe Acrobat reader opens to display the report. You will need to 
select the printer icon to print the report. 
 
PDF format, Print options pop-up dialogue box is displayed. 
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A Print options window displays on your screen. From this window, you 
will be able to specify the number of copies and change the print 
settings for this printing instance of the report. 
 
Select the OK button. 
 
The Print options window disappears and the AM-10 Summary of HTS 
Number by Value Report appears in PDF mode. 
 
You have successfully printed your report in portrait view!  
 
Next we will print another report using landscape orientation. 
 
The AM-10 Summary of HTS Number by Value Report is again 
displayed on the screen.  Menu options include: Document, View, 
Insert drop-down menus, and Find.  The left panel is also displayed 
with the Document Summary showing. 
 
You have already launched InfoView and brought up a report. To print 
a report in landscape orientation, we need to find the report formatting 
option.  This is located in the Document Summary menu. 
 
Select the Document Summary drop-down menu. 
 
The Document Summary Drop-down window displays with the 
following options: Data Summary, Chart and Table types, Available 
Objects, Document Structure and Filters, Navigation Map, User Prompt 
Input and Find. 
 
Select Document Structure and Filters. 
 
The Document Structure and Filters window appears in the left panel. 
 
Important Note: When there is a report with multiple tabs at the 
bottom (aggregate cargo entry report, entry summary compliance 
report, periodic statement detail report, etc.) there is no Report 1 
name to select.  You must click on the individual tab name to select 
the particular report view.   
 
Select Report 1. 
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Report 1 is highlighted in the Document Structure and Filters display 
box. The Format button located below the Document Structure and 
Filters display box.  
 
Select Format. 
 
The Format Report pop-up window displays and contains the following 
tabs:  General, Appearance, Layout Properties. 
 
Select the Layout Properties tab 
 
Layout Properties displays and has the following fields: Page size, 
Orientation, and Margins. 
 
Select the Orientation drop-down arrow. 
 
Orientation sub-menu has the following options: Portrait and 
Landscape. 
 
Select Landscape . 
 
Landscape is highlighted in the sub drop-down menu. 
 
Select the OK button 
 
The report is now displayed in Landscape. 
 
Notice that the report is displayed in the landscape view on the page. 
To print a report in landscape orientation, we need to changed the 
orientation of the PDF file. This is located under the View drop-down 
menu. 
 
Select View drop-down menu. 
 
The View drop-down menu has the following options: Page mode, 
Draft mode, PDF mode, left panel, and Toolbar submenu. 
 
Select PDF mode. 
 
The  AM-10 Summary of HTS Number by Value Report is displayed in 
PDF format. 
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Select the printer icon. 
 
PDF format, Print options pop-up dialogue box is displayed. 
 
A Print options window displays on your screen. From this window, you 
will be able to specify the number of copies and change the print 
settings for this printing instance of the report. 
 
Select the OK button. 
 
PDF format, Print options pop-up dialogue box disappears. 
 
You have successfully printed your report in landscape view!  
 
The AM-10 Summary of HTS Number by Value Report is displayed on 
the screen.   
 
Now that you've learned how to print a report, let's see how you can 
save an electronic copy of the report in a Microsoft Excel format.   
 
Note: Your computer's Internet Security Setting must allow for 
downloads from the Internet for this feature to work. 
 
Note: If a report has multiple tabs at the bottom of the screen, all tabs 
will be included in the exported report. 
 
Select the Document drop-down menu. 
 
The Document drop-down menu is displayed with the following 
options: Close, Save as, Save to my computer as>, and Properties. 
 
Select Save to my computer as. 
 
The Save to my computer as submenu displays with the following 
options: Excel, PDF, CSV, and CSV with options. 
 
Select Excel. 
 
The File Download dialog box appears with buttons to Open, Save, and 
Cancel. 
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Select the Save button. 
 
The File Download dialog box disappears. 
 
Now that you've learned how to export an electronic copy of the report 
in Microsoft Excel, let's see how you can save an electronic copy of the 
report in a PDF format. 
 
Note: Your computer's Internet Security Setting must allow for 
downloads from the Internet for this feature to work. 
 
Select the Document drop-down menu. 
 
The Document drop-down window displays with the following options: 
Close, Save as, Save to my computer as, and Properties. 
 
 
The Document options display. 
 
Select Save to my computer as 
 
Save to my Computer sub-menu has the following options: Excel, PDF, 
CSV, and CSV (with options). 
 
Select PDF 
 
A File download pop-window appears with the option to Open, Save, 
and Cancel. 
 
You will need to select a location on your computer to save the report 
 
Select the Save button. 
 
The File download pop-up window disappears. The AM-10 Summary of 
HTS Number by Value Report is displayed on the screen. 
 
You've now learned how to export a report in a PDF format. 
 
To Summarize... 
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• You learned how to print a report directly from the InfoView 
portal and how to customize print settings. 

• Your learned how to export the report into two different formats 
so it can be used in the future. 

 
Knowledge Check 1 
 
How can you print a report directly from the InfoView portal? 
 
A) Print from a PDF. 

 
B) Print using your browser. 

 
C) Select the print icon from the Navigation menu. 

 
D) None of the above. 

 
The correct answer is A. 

 
 
Knowledge Check 2 
 
To which of the following formats can you export a report? 
 
A) Microsoft PowerPoint 

 
B) Microsoft Excel 

 
C) PDF 
 
D) Both B & C 
 
The correct answer is D. 
 
You have completed this lesson.  In this lesson, you learned how to 
print a report, customize print settings and export reports using two 
different formats. 
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Lesson 8: Authorized Data Extract (ADE) 
 
In Lesson 8: Automated Data Extract (ADE), you will learn how to 
schedule, download and view data using ADE reports. 
 
After completing this lesson, you will be able to: 
 

• Schedule ADE Reports. 
• Download ADE Reports that have been run. 
• View downloaded data in Excel and Access. 

 
Introduction to ADE 
The ACE Reports application is designed to work with interactive, Web-
based reports.  However, some reports you may require have 
particularly large amounts of data.  As with any Web-based system, 
ACE Reports can have trouble with large datasets. Authorized Data 
Extract (ADE) reports allow Trade Account Owners (TAOs) and Proxy 
TAOs to download large reports that would otherwise be too much for 
the ACE Reports system to handle. 
 
Because of their size, ADE Reports cannot be viewed within the ACE 
Reports window.  They must be downloaded to your computer to be 
viewed. 
 
The Reports are downloaded as a Zip file. The Zip contains a text file 
(.txt) -- which shows the size of the report -- and a Comma Separated 
Values (.csv) file -- which is the actual report. 
 
The ACE Reports home page is displayed on the right side of the 
screen. One the left side is the Folders panel with options of Home and 
expandable subfolders of My Folders and Public Folders. 
 
Using ADE reports is a three-step process.  
 
In Step 1, we will locate the report we wish to run and schedule it.  
The reports are located in the Authorized Data Extract public folder. 
 
Select the + sign next to Public Folders. 
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Public Folders is expanded to display the following sub-folders: 
Account Management, Account Revenue, Authorized Data Extract, 
Entry Summary, Reference, and Transactions.  
 
Select the Authorized Data Extract folder. 
 
Authorized Data Extract panel displays on the right side of the screen. 
It contains seven reports. Each report has the following options: View 
Latest Instance, History, Schedule, and Properties and Folders panel.  
AD-001 Entry Summary Report will be the example report. 
 
Select the Schedule link. 
 
The Schedule panel displays with the Modify values button shown to 
the left of a series of prompts whose values can be adjusted. 
 
Select the Modify values link. 
 
The Prompts dialogue box displays and shows the following prompts: 
Broker Code, Importer Number, Include Entries with no Entry Date, 
and Entry Report Creations Date (Begin and End). There is a scroll bar 
to the right of these prompts, indicating that there are other prompts 
out of view. 
 
Scroll down. 
 
Two new prompts display: Entry Report Entry Date (Begin) and Entry 
Report Entry Date (End). 
 
Select the Entry Report Entry Date (Begin) link. 
 
The Entry Report Entry Date (Begin) text box displays with a calendar 
icon to the right of the text box. 
 
Select the Calendar icon. 
 
The Calendar pop-up window displays with a default of February 2008. 
To the right of the date, there are arrows that allow for a previous or 
next year and month to be chosen. To the left of the date, there are 
arrows that allow for a different month to be selected. 
 
Select the Down Arrow to change the year to 2006. 
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The Calendar pop-up window displays the month February 2006. The 
dates on the calendar can be selected. 
 
Select February 1, 2006 
 
The Calendar pop-up window disappears. The Prompts dialogue box 
displays. The Entry Report Entry Date (Begin) text box is now set to 
February 1, 2006. 
 
Select the Entry Report Entry Date (End) link. 
 
The Entry Report Entry Date (End) link text box is displayed with the 
calendar icon to the right of the box. 
 
Select the Calendar icon. 
 
The Calendar pop-up window displays with a default of February 2008. 
To the right of the date, there are arrows that allow for a previous or 
next year and month to be chosen. To the left of the date, there are 
arrows that allow for a different month to be selected. 
 
Select the Down Arrow to change the year to 2006. 
 
The Calendar pop-up window displays the month February 2006. 
 
Select the Up Arrow to change the month to March. 
 
The Calendar pop-up window displays the month March 2006. The 
dates on the calendar can be selected. 
 
Select March 31, 2006. 
 
The Calendar pop-up window disappears. The Prompts dialogue box 
displays. The Entry Report Entry Date (End) text box is now set to 
February 1, 2006. 
 
Note that the Entry Report Creation Date (End) prompt defaults to 
1/1/2007.  You must ensure that the Entry Report Entry Date range is 
within the Creation Date range, otherwise some data may not appear. 
 
To the right of the prompts in the Prompts dialogue box are two 
buttons, Apply and Cancel. 
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Select the Apply button. 
 
The screen returns to the Schedule panel. The Entry Report Creations 
Date (Begin and End) and Entry Report Entry Date (Begin and End) 
are populated with the information set in the previous steps. In the 
lower right corner of this screen are two buttons, Schedule and Cancel. 
 
Select the Schedule link. 
 
The ACE Report home page is displayed on the right side of the 
screen. One the left side is the Folders panel with options of Home and 
subfolders of My Folders and Public Folders. 
 
So far we have scheduled an ADE report to run overnight.  Now we are 
going to move to step 2 in this process: Downloading the report to 
view it. 
 
The simulation has taken you to a new location within ACE. Folders 
panels are displayed on the left side of the screen, with options of 
Home and subfolders of My Folders and Public Folders. The History 
panel is displayed on the right side of the screen. Report AD-001 Entry 
Summary Report is displayed in the History panel. 
 
Select the Home link 
 
The ACE Report home page is displayed on the right side of the 
screen. One the left side is the Folders panel with options of Home and 
the expandable sub-folders of My Folders and Public Folders. 
 
The second step in the three-step ADE report process is downloading 
the report.  The reports are generally too large to conveniently view in 
the Web browser.  If they were run from the internet, they would run 
very slowly and slow your network noticeably.  For that reason, the 
files must be downloaded to your local system to be viewed.   
 
Additionally, ACE only retains three instances of a particular ADE 
report in your Inbox folder, with the oldest instance being deleted 
when a new one is run.  Therefore it is often best to save copies locally 
so that they can be easily accessed later. 
 
Select the + next to My Folders. 
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The Folders panel expands to display the following options: Favorites 
and Inbox. 
 
Select the Inbox link. 
 
The Inbox panel displays on the right side of the screen. It contains a 
Shortcut to AD-001 Entry Summary Report: 255642. 
 
Select the Shortcut to AD-001 Entry Summary Report: 255642 links. 
 
The File Download dialogue box displays with the options to Open, 
Save, or Cancel the AD-001_Entry_Summary_Report.zip file. 
 
Select the Save button. 
 
The File Download dialogue box is replaced with the Save As dialogue 
box. The My Documents icon is located on the left side of the dialogue 
box along with Recent, Desktop, My Computer, and my Network.  The 
file being saved is defaulted to AD_001_Entry_Summary_Report.zip. 
 
Select My Documents. 
 
The Save as dialogue box displays all the folders located in the My 
Documents folder. One of the folders is named Reports.  
 
Open the Reports item. 
 
Selecting the Reports folder opens a sub-folder, Graphics for reports. 
 
Select the Save button. 
 
The Download complete dialogue box displays, replacing the Save as 
dialogue box. The Download complete dialogue box indicates that the 
zip file has been saved to the Reports folder. At the bottom of this 
dialogue box are three buttons: Open, Open Folder, and Close. 
 
Select the Close button. 
 
The Please wait Open document dialogue box displays over the AD-001 
Entry Summary Report panel. The Folders panel, containing the Home 
icon, is displayed on the left side of the screen. 
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Select the Home link. 
 
The ACE Report home page is displayed on the right side of the 
screen. One the left side is the Folders panel with options of Home and 
the expandable sub-folders of My Folders and Public Folders. 
 
Now that we have downloaded the report, we will take a look at how to 
view the data. 
 
The course simulation has redirected your view to a view of a 
computer desktop with a My Documents icon on the upper left side of 
the screen. 
 
Step 3 in the 3-step ADE process is opening and viewing the 
downloaded report.  The reports are downloaded as a Zipped package 
including the report itself and a text file indicating the size of the 
report in rows.  Smaller reports, those with fewer than 65,536 rows, 
can be viewed in Microsoft Excel.  Larger files must be viewed in 
Microsoft Access.  In this lesson, we will see both modes of viewing 
files.   
 
First, we will open the Zip file and view the text file to check the size of 
the report. 
 
Open the My Documents item. 
 
My Documents folder window displays containing various folders and 
files. One of the folders is entitled, Reports Folder. 
 
Open the Reports Folder item. 
 
The Reports Folder open and contains the following zipped file, AD-
001_Entry_Summary_Report.zip 
 
Open the AD-001_Entry_Summary_Report.zip item. 
 
The AD-001_Entry_Summary_Report.zip folder opens and contains 2 
files of the report: Text and Excel. 
 
Open the AD-001_Entry_Summary_Report.index.txt item. 
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A Caution dialogue box displays on the screen, warning that you are 
trying to access the Text file. There are two buttons in the dialogue 
box: Yes and No. 
 
Note that this message may display when you attempt to open the 
text file.  If it does, select the Yes button to close it. 
 
Select the Yes button. 
 
The AD-001_Entry_Summary_Report.index.txt notepad dialogue box 
opens indicating there are 34009 records associated with this report. 
The close button is in the upper right corner of the dialogue box. 
 
Note the number of rows in the file.  If it is less than 65,536, the file 
may be opened in Microsoft Excel.  If it is larger, it must be opened in 
Microsoft Access. 
 
Now we will extract the report from the Zip file and save it normally. 
 
Select the Close button. 
 
The AD-001_Entry_Summary_Report.zip folder displays once again 
with the Text and Excel files associated with this report. At the top of 
this folder window are icons for the following options: New, Open, 
Favorites, Add, Extract, Encrypt, View, CheckOut, Wizard. 
 
If the file can be opened in Excel, you may choose to open it directly 
from WinZip.  In this exercise, we will demonstrate how to extract the 
file to the computer. 
 
Select the AD-001_Entry_Summary_Report_0.csv item. 
 
Select the Extract button. 
 
The Extract pop-up window displays requesting what drive or folder to 
place the unzipped file.  One of the Folders is My Documents. 
 
Select the + next to My Documents. 
 
Under the My Documents folder is the Reports folder. 
 
Select the Reports Folder. 
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In the lower right corner of the Extract pop-up window there are three 
buttons: Extract, Cancel, and Help. 
 
Select the Extract button. 
 
A Win-Zip pop-up window displays indicating the file is being 
extracted. 
 
This window appears while the file is extracted. 
 
The Win-Zip pop-up window disappears. The AD-
001_Entry_Summary_Report.zip folder displays with the Text and 
Excel files associated with this report. The close button is in the upper 
right corner of the folder. 
 
Select the Close button. 
 
My Documents folder displays both files associated with the AD-
001_Entry_Summary_Report. 
 
Open the AD-001_Entry_Summary_Report_0.csv item. 
 
The Microsoft Excel Spread sheet opens.  On the bottom of the screen 
is the option to scroll towards the right to reveal additional 
information. 
 
Scroll to the right. 
 
Microsoft Excel Spread sheet displays text not displayed when first 
opening up the file.  Scrolling back towards the right return to the 
default view of the report. 
 
Scroll to the left. 
 
Microsoft Excel Spread sheet has a red X located in the upper right-
hand corner of the screen. 
 
Select the Close button. 
 
My Documents folder is displayed. Outside the folder,in the lower left-
hand corner of the screen, is the Microsoft Windows Start icon. 
 



Web-based Training Guide for  Module 2, Lesson 8 
ACE Reports for Trade 

73 

Select the Start button. 
 
The Start menu expands on the left-hand side of the screen.  There 
are several menu options, including Program, Documents, Settings and 
Search 
 
Select the Programs menu. 
 
The Programs menu expands to display a list of available computer 
applications. The Microsoft Office item is on this list. 
 
Select the Microsoft Office menu item. 
 
The Microsoft Office menu expands to display the various computer 
applications associated with Microsoft Office, including Microsoft Office 
Access 2003. 
 
Select the Microsoft Office Access 2003 menu item. 
 
A blank Microsoft Office Access screen displays. At the top of this 
window there are numerous menu options. Below these menu options 
is a toolbar containing an Open icon. 
 
Select the Open... button. 
 
The Open dialogue box displays, allowing you to select the location of 
the file you would like to open with Access. The Reports Folder is one 
of several in the My Documents top folder. At the bottom of this 
dialogue box is the Files of type drop-down menu. 
 
Open the Reports Folder. 
 
Opening the folder shows no files and a default of Microsoft Office 
Access file types. The type of file will need to be changed to reflect the 
Text and Excel files extracted earlier. 
 
Select the Files of type drop-down menu. 
 
Microsoft Office Access is the file type currently selected. There is a 
scroll bar in the Files of type drop-down menu, which allows you to 
view other file types 
 
Select the scroll bar. 
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Microsoft Access dialogue box is displayed with additional file types, 
including Text (Exchange, Outlook, Paradox, Text files, Windows 
SharePoint and ODBC databases. 
 
Select the Text Files (*.txt;*.csv;*.tab;*.asc) item. 
 
Selecting Text Files (*.txt;*.csv;*.tab;*.asc) displays all the text files 
within the Reports Folder. The only file listed is the AD-
001_Entry_Summary_Report_0.csv item. 
 
Select the AD-001_Entry_Summary_Report_0.csv item. 
 
The AD-001_Entry_Summary_Report_0.csv item is highlighted in the 
dialogue box. There are two buttons in the lower right corner of the 
dialogue box: Open and Cancel. 
 
Select the Open button. 
 
The AD-001_Entry_Summary_Report_0 database file opens.  Access 
will then pause while opening the text file before starting the Text 
Import Wizard. 
 
The Link Text Wizard dialogue box opens, asking how the user would 
like to break out the report. Default columns include: Carrier Code, 
Carrier Name, Filer Name, Filer Code and Import. Above these 
columns is a checkbox labeled First Row Contains Field Names. 
 
Opening a CSV file in Access requires that the file be converted into 
Access format.  Excel does this automatically.  Access requires the 
user to run a wizard to convert the data.  The wizard simply asks how 
the data is arranged and what separators to look for (commas in this 
case).   
 
The First Row Contains Column Headers check box tells Access that 
the data in the first row will be used to name the fields. 
 
Select the First Row Contains Field Names check box. 
 
To the right of the First Row Contains Field Names check box is the 
Text Qualifier combo box.  
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The Text Qualifier combo box allows you to tell Access that a double 
quotation mark (") is used to indicate text values.  This will have 
access ignore commas inside some fields (such as city, state). 
 
Select the Text Qualifier combo box. 
 
The Text Qualifier combo box drop-down arrow contains the following 
options: double quotation mark (“), single quotation mark (‘), and 
{none}. 
 
Select the double quotation mark ("). 
 
The Link Text Wizard dialogue box displays with the First row Contains 
Field Names. The double quotation mark was chosen in the Text 
Qualifier drop-down menu. At the bottom of the dialogue box are 
several buttons: Advanced…, Cancel, <Back, Next>, and Finish. 
 
Select the Next > button. 
 
The Link Text Wizard dialogue box changes to allow you to select 
either a Delimited (characters such as a comma or a tab separate each 
field) or a Fixed Width (fields are alligned in columns with spaces 
between each field) format. A sample of the selected format type is 
displayed these choices. The same buttons are displayed at the bottom 
of the dialogue box: Advanced…, Cancel, <Back, Next>, and Finish. 
 
Select the Next > button. 
 
The Link Text Wizard dialogue box changes to allow you to modify the 
field name and data type for each field you are importing. The same 
buttons are displayed at the bottom of the dialogue box: Advanced…, 
Cancel, <Back, Next>, and Finish. 
 
Select the Next > button. 
 
The Link Text Wizard dialogue box changes to display the Linked Table 
Name. The Linked Table Name field can be edited. The same buttons 
are displayed at the bottom of the dialogue box: Advanced…, Cancel, 
<Back, Next>, and Finish. 
 
Select the Finish button 
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A Link Text Wizard pop-up window displays, alerting you to the fact 
that the table has been linked to the specified AD-
001_Entry_Summary_Report_0 database file. At the bottom of this 
window there is an OK button. 
 
Select the OK button. 
 
The AD-001_Entry_Summary_Report_01: Database dialogue box 
displays. Witin this dialogue box, AD-001_Entry_Summary_Report_0, 
is highlighted. 
 
When the import is completed, the text file will appear in Access's 
Tables list. 
 
Open the AD-001_Entry_Summary_Report_0 item. 
 
The Access version of table format of the report displays on the 
screen. There is a Scroll bar on the bottom of the window. There is a 
Close button (red X) in the upper right corner of the window. 
 
Scroll to the right to review some of the data. 
 
Select the scroll bar. 
 
Select the Close button. 
 
The AD-001_Entry_Summary_Report_01: Database dialogue box 
displays within the Microsoft Access window. The Close button (red X) 
is located in the upper right corner of the Microsoft Access window. 
 
Select the Close button. 
 
The Reports Folder window Displays. The Close button (red X) is 
located in the upper right corner of the Reports Folder window. 
 
Select the Close button. 
 
You have returned to the view of a computer desktop. 
 
We have now finished scheduling, downloading and viewing ADE 
reports. 
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To Summarize... 
• You learned how to schedule Authorized Data Extract (ADE) 

reports. 
 

• You learned how to download reports from the Inbox. 
 

• You learned how to view ADE Reports in Excel and Access. 
 
 
Knowledge Check 1 
 
In what format can ADE Reports be viewed? 
 
A) Interactive HTML 

 
B) Adobe PDF 
 
C) Microsoft Excel or Access 
 
D) All of the above 
 
 The correct answer is C.  
 
 
Knowledge Check 2 
 
What distinguishes ADE Reports from other ACE Reports? 
 
A) They contain smaller amounts of data than normal reports 

 
B) They must be downloaded, scheduled, and viewed from the 
desktop. 
 
C) Because they are plain text, they run very quickly. 
 
D) Nothing distinguishes them, they are just another report. 
 
The correct answer is B. 
 
 
Knowledge Check 3 
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What is the maximum number of rows a report may have to open in 
Excel 2003. 
 
A) 1,024 

 
B) 65, 536 
 
C) 1,048,576 
 
D) There is no maximum. 
 
The correct answer is B.  
 
You have completed this lesson.  In this lesson, you learned how to 
schedule, download, and view the data in Authorized Data Extract 
(ADE) reports. 
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Module 3: Ad Hoc Functionality 
Lesson 1: Introduction to ACE Reports 
 
In Lesson 1: Introduction, we will introduce the components and 
capabilities of the ACE Reports Ad Hoc Reporting Functionality.  
Additionally, we will identify the Ad Hoc Reporting Function's basic 
interface components. 
 
After completing this lesson, you will be able to: 
 

• Identify the benefits of using the Ad Hoc reporting functionality. 
• Define the major organizational components within the Ad Hoc 

functionality. 
• Recognize the Edit Query and Edit Report modes. 
• Recognize the Ad Hoc interface. 

 
What is Ad Hoc Reports? 
The Ad Hoc Reporting functionality is a newly added, advanced feature 
within ACE Reports. The Ad Hoc function provides improved reporting 
performance, greater customization and flexibility, and additional 
available data objects. 
 
Essentially, users will be able to build reports to their exact 
specifications. 
 
The ACE secure portal is displayed and divided into the Folders panel 
on the left and the Account Revenue panel on the right. The Account 
revenue panel contains all the public Account Revenue reports. Below 
the link to each report are links for Schedule, Modify, and Properties. 
 
To access Standard Reports, we would select the Report title link.  To 
access the Ad Hoc functionality, select the Modify link. 
 
The Prompts dialogue box displays. In the bottom right corner of the 
dialogue box there are two buttons, Run Query and Cancel. 
 
Similar to Standard, or non Ad Hoc enabled reports, the Prompts 
dialog box automatically opens.  Since we are going to customize this 
report, we will delay setting the prompts by canceling the pop up box. 
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Select the Cancel button. 
 
The Business Objects loading screen displays. 
 
This is the loading screen for the Ad Hoc Tool.  The application will 
automatically progress. 
 
The ACE secure data portal is in the background, the Data panel 
displays on the left-hand side and the  AR-002 Aged Entry Data 
Workspace displays on the right-hand side of the screen. At the top of 
the screen (above the Data panel and the Report Workspace) are three 
toolbars, the top-most of which contains the Edit Query and Edit 
Report tabs. 
 
We are currently in Edit Report mode, which is the first page within the 
Ad Hoc Tool users will see.  This mode allows users to modify the 
appearance of query by formatting the tables and charts pictured here.  
Users can select the Edit Query tab to toggle between these two facets 
of the Ad Hoc function. 
 
On the left side of the screen is the Data Panel. The Data Objects that 
are selected under the Edit Query tab appear in this window. Note:  
Some Data Objects are included as default settings.  
 
Users can toggle from Edit Report to Edit Query mode by selecting the 
Edit Query tab. 
 
Select the Edit Query tab. 
 
3 panels display for the AR-002 Aged Entry Data. These panels are: 
The Data panel on the far left, containing all of the data objects 
available for that report. The Results Objects to the right of the Data 
panel, on the top of the screen. The Results Objects panel contains the 
data elements that are to be displayed in the final report. Directly 
below the Results Objects panel is the Query Filters panel, containing 
the filters that limit the data that will be displayed in the report.  
 
In the Edit Query mode, users can choose from a complete list of data 
objects, filters, and other information that will be displayed in the 
report.   
 
Scroll down to view the all of the elements within the Data panel. 
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As the user scrolls down the menu, the icons associated with the data 
objects change. All icons of one typw are grouped together. 
 
Notice the Data Objects are organized within each folder by Qualitative 
Data Object, Quantitative Data Object, and Query Filter.  
 
The Data panel, displays blue square icons to represent Qualitative 
Data Objects, pink circles to represent Quantitative Data Objects, and 
yellow funnels to represent Query Filters.  
 
Data Panel Item Naming Convention 
 
There are several elements represented within the Data Panel.  They 
are identified with their terms below. 
Universe – The top level (folder) within ACE Reports. Within Edit Query 

mode, a Universe is represented by an icon made up of a 
blue square, pink circle, and green triangle.  

Classes – The folders within a Universe. Within Edit Query mode, a 
Class is represented by a folder icon with the Universe logo 
displayed on the folder. 

Data Objects – Data Objects are found within the Classes. Qualitative 
Data Objects are represented by blue square icons, 
while Quantitative Data Objects are represented by 
pink circle icons.  

Filter Object – Filter objects are also found within Classes. Filter 
objects are represented by yellow funnel icons. 

 
Ad Hoc Naming Convention and Definitions 
 
The icons below appear on the Data Panel of the Ad Hoc Tool's Edit 
Query mode.  The icons correlate with the terms beside them.  Terms 
without icons cannot be found within the Data Panel, but are integral 
to the Ad Hoc reporting tool.   
 
Terms and Icons 
 
Universe - Universes house the main categories of the information 
available in databases.  Universes are made up of categories called 
classes and objects.  In the ACE Reports Ad Hoc Reporting Tool, the 
information within each universe can be collapsed and expanded by 
selecting the + and - icons. 
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Classes - Classes are logical groups of objects with meaningful names. 
 
Data Objects - Data Objects are named components that directly 
correlate to data in the database. 
 
Filter Objects - Filter Objects are controls that limit the amount of data 
returned in queries 
 
Additional Terms 
 
Reports - Reports are the output or appearance of database queries. 
 
Queries – A query is a request for data from the database. 
 
Types of Data Objects 
There are 2 types of Data Objects 
 
Qualitative Data Objects - set text values such as IR numbers, Port 
Codes, and many more.  Qualitative Data Objects are denoted by blue 
boxes. 
 
Quantitative Data Objects - numerical values such as Totals and 
Transaction Amounts. Quantitative objects are NOT necessarily the 
result of a calculation, though they can be.  Only quantitative objects 
can be used in calculations.  Quantitative Data Objects are denoted by 
pink spheres. 
 
Examples of Qualitative Data Objects include:  
Processing Port Name 
Broker Reference Number 
Reversed by Document Number 
Status 
Status Number 
Update Date and Time 
Entry Date 
Release Date 
 
Examples of Quantitative Data Objects include: 
Open Total 
Total 
Tax 
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Fees 
Duty 
CVD 
ADD 
 
Filter Objects 
 
Filter Objects are used to limit the data that is pulled from the 
database into the report.  They are pre-defined, prompted filters that 
can be added to the Query Filters pane and will prompt the user for 
data when the report is run.  The Filter Objects cannot be changed, 
and may only be added to the Query Filters pane. 
 
Examples of Filter Objects include: 
Status 0 Records 
Status 
Processing Port Codes 
Monthly Statement Number 
Daily Statement Number 
Periodic Monthly Stmt Date 
Payment Basis Indicator 
Payment Due Date 
Entry Number 
 
New Date Objects 
 
Date Objects is a class within ACE Reports.  
 
Date objects enable reports to display continually updated data that 
matches variable dates or date ranges.  Data objects are used in the 
Query Filters pane.   
 
Notice that Date Objects are all Qualitative Objects denoted by the 
blue boxes. 
 
Examples of Date Objects include: 
Today 
Julian Today 
7 Days Ago 
45 Days Ago 
180 Days Ago 
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Previous Week Start 
Previous Week End 
 
Incompatible Data Objects 
 
Incompatible objects are data objects which bear no relationship to 
one another and cannot be combined in the same report.  
 
Incompatible objects cannot be added to the same table. 
 
To Summarize... 
 

• In this lesson, you learned about the Ad Hoc Reporting tool's 
basic organization and interface. 

 
 
Knowledge Check 1 
 
How do you access the Ad Hoc functionality? 
 
A) Select the report name which is a link. 
 
B) Select the “View Last Instance” link 
 
C) Select the “History” link 
 
D) Select the “Schedule” link 
 
E) Select the “Modify” link 
 
F) Select the “Properties” link 

 
The correct answer is E.  
 
 
Knowledge Check 2 
 
What are Incompatible Data Objects? 
 
A) Information combined from the Edit Report and Edit Query tabs.  

Incorrect – The correct answer is B. Select Next to continue. 
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B) Query Filters, Quantitative Data Objects, and Qualitative Data 
Objects being combined in the same report. 
 
C) Data Objects which bear no relationship to one another and cannot 
be combined in the same report. 
 
The correct answer is C.  
 
 
You have completed this lesson.  In this lesson, you learned about the 
Ad Hoc Reporting tool's basic organization and interface. 
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Lesson 2: Modifying Reports 
 
In Lesson 2: Modifying Reports, we will demonstrate the Ad Hoc 
capability of restricting and including the data elements that appear in 
reports. 
 
After completing this lesson, you will be able to: 
 

• Add/Remove Data Objects and Query Filters to/from Reports in 
the Edit Query mode. 

• Add/Remove Data Objects from Reports in the Edit Reports 
mode. 

 
Using Ad Hoc Enabled Reports 
 
The ACE secure portal is displayed and divided into the Folders panel 
on the left and the Search Results: title contains “AR-002” panel on 
the right. The panel on the right contains all reports whose titles 
include “AR-002”. Below the link to each report are links for Schedule, 
Modify, and Properties. 
 
The procedure to open Ad Hoc Reports is the same as accessing 
Standard Reports with one difference.  Instead of selecting the report 
name link, select the Modify link relating to the desired report. 
 
We will now demonstrate the Edit Report and Edit Query modes within 
the Ad Hoc application tool. 
 
Selecting Modify takes you to Edit Report mode once again. The ACE 
secure data portal is in the background, the Data panel displays on the 
left-hand side and the AR-002 Aged Entry Data Workspace displays on 
the right-hand side of the screen. At the top of the screen (above the 
Data panel and the Report Workspace) are three toolbars, the top-
most of which contains the Edit Query and Edit Report tabs. 
 
This is the Edit Report Data Panel. The data panel in the Edit Report 
mode only features the Data Objects and Query Filters that have been 
selected from the greater universe of Data Objects and Query Filters 
within the Edit Query mode. 
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Essentially the data panel only displays the objects included in the 
standard report or those objects necessary to run the standard report. 
 
Select the Edit Query tab. 
 
You are now in Edit Query mode. 3 panels display for the AR-002 Aged 
Entry Data. These panels are: The Data panel on the far left, the 
Results Objects to the right of the Data panel, on the top of the 
screen, and directly below the Results Objects panel is the Query 
Filters panel. The Data panel displays the classes within the Account 
Revenue Universe: Receivables, Inventory, Broker, Importer,District 
Port, Carrier, ALL Objects, Date Objects, and LoVs. 
 
Select the + icon next to the Receivables folder. 
 
The Receivables folder is now open and the list of data objects 
appears. 
 
Scroll down. 
 
We will now add a data object to the report. 
 
Select the Processing Port Name data object 
 
The Processing Port Name data object is now added to the Result 
Object Pane. 
 
Scroll down. 
 
Select the + icon next to the Broker folder 
 
We will now add another data object to the report. 
 
Select the Filer Code data object. 
 
After selecting the data object (in this case Filer Code) within the data 
pane, it appears in the Result Objects pane. 
 
Select the + icon next to Importer. 
 
We will now add another data object to the report. 
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Select the Importer Number data object. 
 
The Result Objects panel now contains the following list of Data 
Objects: Filer Name, Importer Name, Creation Date, Entry Totl Amt, 
District Port Code, Processing Port Name, Filer Code, and Importer 
Number. 
 
Scroll down. 
 
Select the Entry Number data object 
 
The Entry Number Data Object has been added to the Result Objects 
panel. 
 
Users can also move data objects to the Results Objects pane by 
dragging and dropping items. 
 
We will now add another Data Object to the report. 
 
Note: To highlight and move several items, select each by holding the 
Ctrl key.  If the items are ordered consecutively, select the first item, 
hold the Shift key, then select the last ordered item.  Every item 
between the first and last will be highlighted.  After the desired Data 
Objects are highlighted, drag and drop any of the highlighted items 
and all of the highlighted items will appear in the Result Objects pane. 
 
To delete items in the Result Objects panel, select the item with the 
mouse then press the Delete key.   
 
Note: Users can also omit data objects by selecting and dragging 
items from the Result Objects pane and drop them back into the Data 
Objects Panel.   
 
Select the Entry Number data object and press the Delete key. 
 
The Entry Number Data Object is now deleted from the Result Object 
Pane and will not appear in the Data Object Panel within the Edit 
Reports tab. 
 
We will now focus on adding and removing Data Objects and Filter 
Objects from the Query Filters Pane. 
 
Scroll down in the Data panel. 
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Adding and removing Filter Objects and Data Objects in the Query 
Filters Pane entails the same process as adding and removing 
elements in the Result Objects Pane. 
 
We will begin by adding a Filter Object to the Query Filters Pane. 
 
Note: Open the + icon next to their respective Classes to find specific 
Data Objects and Filter Objects. 
 
Select the Filer Codes Query Filter entry. 
 
Within the Query Filters panel, the Filer Codes Query Filter appears. 
 
Note:  When Filter Objects are selected they appear in the Query Filter 
pane by default just as data objects will appear in the Result Objects 
Pane. 
 
Now we will remove the Filer Codes, Query Filter from the Query 
Filters Pane. 
 
Select the Filer Codes Query Filter and press the Delete key. 
 
The Query Filter is removed from the Query Filters Pane. 
 
Note: Another way to remove a Query Filter is to select the item with 
the mouse, drag the item to the panel section and release the mouse 
select. 
 
Next we will add a Data Object to the Query Filters Pane. 
 
Note: Data objects can be used in the Query Filter Pane.  They must 
be dragged and dropped in place.   
 
Select the Filer Code, data object. 
 
When using ACE Reports software, you will drag the Data Object into 
the Query Filter Pane and release it where you would like it to appear.   
 
The Filer Code Data Object displays with Importer Numbers and 
Creation Date in the Query Filters panel. Next to the Filer Code Data 
Object title is an In list drop-down menu, and a text field with a value 
type drop-down menu to its right.  
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Select the In list drop-down arrow. 
 
The drop-down menu opens.  
 
This menu displays the following options: 
Equal to, Not Equal to, Greater than, Greater than or Equal to, Less 
than, Less than or Equal to, Between, Not Between, and In list. 
 
Note: When Data Objects are inserted into the Result Objects Pane 
they will represent a single column within the report whereas Data 
Objects inserted into the Query Filters Pane will limit the data included 
in the report.  
 
Select Equal to. 
 
Select the value type drop-down menu. 
 
This drop-down menu includes the following options: Constant, 
Value(s) from list, and Prompt. 
 
Select Constant. 
 
Select the text box. 
 
Numbers 1,2,3 are typed into the text box. 
 
After the Query Filters are set, we will run the report. 
 
Above the Result Objects panel, in the upper right corner of the 
screen, there is a Run Query button. 
 
Select Run Query. 
 
The Retrieving Data dialogue box is displayed in the middle of the 
screen. It shows the amount of time left to run the query. 
 
Please wait patiently when this screen appears.  The information you 
have entered is loading.  If you want to cancel the report select the 
Cancel button at the bottom right of the pop-up window. 
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The Prompts dialogue box appears.  This pop-up will always appear 
after selecting the Run Query button and provides you with another 
opportunity to limit the data that will be presented in the report.   
 
Note: The report can only be run if all of the prompts are marked with 
green circle check.  If there is not a green check, select the prompt to 
determine which information will be presented in the report. 
 
A Run Query button is in the bottom right corner of this dialogue box. 
 
Select Run Query. 
 
The AR-002 Aged Entry Data report is displayed and contains the 
following headers: Importer Name, Filer Name, Payment Due Date, 
Clearing Date, and Total. 
 
The report automatically renders in Edit Report mode.  Not all of the 
Data Objects we selected in Edit Query mode are included in the 
report.  We will modify this report by adding a Data Object to this 
report. 
 
Note: When using this application, Right Select within the report to 
perform modifications.  
 
Select The Filer Name column header 
 
Selecting the Filer Name column header activates an associated menu 
that contains the following options: Insert, Copy as Text, Clear cell 
contents, Remove, Remove Row, Remove Column, Format Number, 
Format Toolbar, Edit Format, Sort. 
 
Select Insert. 
 
A sub up menu displays and contains the following options: Insert 
Column Before, insert Column after, Insert Row above, Insert Row 
below. 
 
Select Insert Column before. 
 
A new column displays between the Importer Name and Filer Name 
Headers. 
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The new column is created.  You can now include additional Data 
Objects by dragging and dropping each item into blank columns. 
 
The new column is populated with the Importer Number Data Object 
and its associated data. 
 
After a new column is created, you can then include additional Data 
Objects by dragging and dropping each item into a blank column. After 
the Data Object is dropped in place, each row is populated with that 
information. 
 
Note: When using this functionality, Right Select the report within the 
Ad Hoc interface. Cell height and widths can be resized by selecting a 
border, drag and release when the cell is resized to your preferences.  
As you resize cells, a thin line will appear and extend the length of the 
screen vertically for columns and horizontally for rows. 
 
Select the Importer Number column header. 
 
Selecting the Importer Number column header activates an associated 
menu that contains the following options: Insert, Copy as Text, Clear 
cell contents, Remove, Remove Row, Remove Column, Format 
Number, Format Toolbar, Edit Format, Sort. 
 
Select Insert.  
 
A sub up menu displays and contains the following options: Insert 
Column Before, insert Column after, Insert Row above, Insert Row 
below. 
 
Select Insert Column after. 
 
The new column appears after the Importer Number column. 
 
Cell widths and heights can be customized by selecting cell borders 
with a mouse select, dragging that border to the desired size and 
releasing the select. 
 
Select the cell below it will be resized for you. 
 
The new column was resized. 
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Now we will remove a Data Object from the report.   
 
Note: When using ACE, select the menu to get the following drop-
down menu. 
 
Select the Filer Name column header. 
 
Selecting the Filer Name column header activates an associated menu 
that contains the following options: Insert, Copy as Text, Clear cell 
contents, Remove, Remove Row, Remove Column, Format Number, 
Format Toolbar, Edit Format, Sort. 
 
Select Remove Column. 
 
The ACE secure data portal, AR-002 Aged Entry Data report is 
displayed minus the Filer Code column. 
 
The Filer Name Data Object is no longer included in this report. 
 
Note: The table is column dominant, meaning wherever the user 
selects or right selects inside the report, that column will be selected 
and the same pop up box will appear. 
 
To Summarize... 
 

• In this lesson, you learned how to add and remove Data Objects 
and Query Filters from both the Edit Query and Edit Report 
modes. 

 
 
Knowledge Check 1 
 
To highlight and move several Data Objects, _____________. 
 
A) Select each by holding the Ctrl key 

 
B) Select the “View Last Instance” link. 
 
C) Select Enter. 
 
D) None of the above. 
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The correct answer is A.  
 
 
Knowledge Check 2 
 
Data Objects can be used in the Query Filters pane by 
 
A) underlining them.  

 
B) dragging and dropping them there. 
 
C) Data Objects cannot be used in the Query Filter pane. 
 
The correct answer is B.  
 
You have completed this lesson.  In this lesson, you learned how to 
add and remove Data Objects and Query Filters from both the Edit 
Query and Edit Report modes. 
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Lesson 3: Saving Modified Reports 
 
In Lesson 3: Saving Modified Reports, we will demonstrate the Ad Hoc 
capability to save reports. 
 
After completing this lesson, you will be able to: 
 
• Save Modified Reports 
 
Standard Reports Tool Bar vs. Ad Hoc Reports Tool Bar 
 
The Standard Reports Tool Bar is organized in two rows and contains 
the following: 
Document drop-down menu 
View drop-down menu 
Insert drop-down menu 
Find button 
Undo and Redo Action buttons 
Zoom drop-down menu 
Page number selection  
Refresh Data button 
Magnification button 
General document formatting icons, menus, and buttons 
 
The Ad Hoc Reports Tool Bar is organized in three rows and contains 
the following: 
New document button 
Save icon/drop-down menu 
Print button 
Edit Query button 
Edit Report button 
Refresh Data button 
Help drop-down menu 
Formula button 
Undo button 
Alerters button 
Insert chart drop-down menu 
Quick filter button 
Sort drop-down menu 
Summary function drop-down menu 
View structure button 
Drill button 
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Snapshot button 
General document formatting icons, menus, and buttons 
 
Please note that Standard Reports Toolbar is unlike the Ad Hoc Reports 
Toolbar.  Even basic functions such as saving and retrieving reports 
are different. 
 
AR-004 Late Payment Report is displayed on the right side of the 
screen. You are currently in Edit Report mode and the Ad Hoc Reports 
Toolbar is displayed at the top of the screen. 
 
Once a report has been modified in both Edit Query and Edit Report 
modes, we will save the report. 
 
Select the drop-down arrow next to the Save, or disc icon. 
 
The Save drop-down menu expands and includes the following 
options: Save as…, and Save to my computer as. 
 
Select Save as from the drop-down menu. 
 
The Save Document dialogue box pop-up window displays. This 
dialogue box contains the following text boxes, checkboxes, and 
buttons: Title text box, Description text box, Keywords text box, 
Refresh on open check box, Permanent Regional Formatting check 
box, Location field, OK button, and Cancel button. The title, AR-004 
Late Payment Report Sample in Title text box. The checkbox for 
Refresh on open is active. 
 
When saving reports in the Ad Hoc tool, insert the report name in the 
field below. 
 
De-select the Refresh on open check box. 
 
Within the Location field, My Folders and Public Folders are displayed. 
Public Folders is currently expanded to display its sub-folders. My 
folders is collapsed currently. 
 
Select My Folders. 
 
My Folders is expanded. The Favorites sub-folder is displayed.  
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Select the Favorites folder. 
 
Select the OK button. 
 
AR-004 Late Payment Report is displayed. 
 
The Report is now saved and can be found in the Favorites folder 
located on the Data Panel. 
 
To Summarize... 
 

• In this lesson, you learned how to save modified reports. 
 
 
Knowledge Check 1 
 
In which folder will you save ad hoc reports? 
 
A) Public Folders 

 
B) Inbox 
 
C) Account Revenue 
 
D) Favorites 
 
The correct answer is D. 
 
You have completed this lesson.  In this lesson, you learned how to 
save modified reports. 
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